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GroBoto 3d Modeling & Imaging
A unique perspective...


What GroBoto is... and isn’t
We are different. 


GroBoto is not designed to replicate or 
refine toolsets and methods found in well 
established 3D applications. Rather, it 
endeavors to offer new approaches that 
make 3D Modeling & Imaging  more 
intuitive, more artistic, more productive, 
and less technical. 


GroBoto v3 new Modeling & Mesh 
Creation tools make it fully compatible 
with the Big World of 3D/CGI.


Using THis Document
If you are a seasoned GroBoto Version 2 
user, Most of what’s here is not new. 
Searching for ‘v3 Note’ will help you find 
v3 updates and notes. Again the best 
source for Version 3 Documentation is 
online: www.groboto.com/v3docs


If you are new to GroBoto, this Document 
is a vital resource for basic concepts, tools 
and workflow. It will help make your crea-
tive time more enjoyable & productive.
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Important Notes:
GroBoto v3’s New Features, 
emphasizing Modeling & Meshing,
will expand & evolve throughout the 
version 3 cycle. 


The main & best source of 
documentation and Tutorial Videos for 
all new v3 features is online:
www.groboto.com/v3docs


Look for these Green ‘Stickies’ 
throughout this Document, they will 
guide you to related online resources.


The general interface and workflow 
information found here is relevant to 
the new Modeling features.


This Document is also the best source 
for info on ‘Classic’ GroBoto features 
including Bots, Rendering, Textures & 
Morph Animation.



http://www.groboto.com/v3docs

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs
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GroBoto modeling & meshing
Primitive/Boolean Modeling & SeamNet Meshes


is section is a brief overview of  Modeling  & Mesh-Generation 
features in GroBoto v3. Since these tools and systems are likely to evolve 
rapidly, the main & best source of Documentation and Tutorial 
Videos for these features is online: www.groboto.com/v3docs .


GroBoto Modeling
All GroBoto Modeling begins 
with simple Primitives — 
Spheres, Cones, Cylinders, etc. 
Your are free to assemble them 
in any desired fashion. 


Next come Booleans (the ability 
to trim away parts of your 
model with subtractive 
surfaces).  


With that combination of 
Primitives and Boolean 


arrangements, you 
can create almost 


anything — at 


least a stylized version of almost 
anything. However, the Quadric 
Primitives used in GroBoto are rigid 
forms. To get beyond that limitation — 
and have a path to the broad world of 3D 
Modeling — you need a mesh....


Automated SeamNet Meshes
It is certainly possible to create 
wonderfully clean, clever models and 
images in GroBoto without ever 
generating a mesh. None the less, 
GroBoto is a uniquely powerful and 
sophisticated mesh creation tool.


Our SeamNet meshes can be generated 
in seconds from any arbitrary 
arrangement of Primitives and Booleans. 
ose meshes — very nicely structured 
for further modeling and sculpting in 
other 3D applications — can also be 
smoothed and otherwise stylized at 
creation time.


Modeling • Getting Started
e next few pages will help you find the 
tools and features within GroBoto — as 
well as Videos, Samples and other 
Resources — needed to get you going.
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GroBoto modeling is 
based on simple 
Primitives and Booleans. 
This has long been seen 
as an intuitive and natural 
way to model, but 
attempts to implement it 
have come up short. 


By combining real-time 
true-geometry editing 
with fully automated 
generation of a quality 
mesh, GroBoto makes 
this approach viable.



http://www.groboto.com/v3docs

http://www.groboto.com/v3docs





Geometry Types and Boolean Modeling


GroBoto Geometry Types
All modeling in GroBoto is based on 
simple Geometric Primitives. ere are 
no meshes in GroBoto.  


GroBoto can automatically turn virtually 
any arrangement of those Primitives into 
a mesh, but you will not find any 
polygons or polygon editing tools in 
GroBoto (aside from the ability to 
smooth and otherwise ‘stylize’ those 
automatically generated meshes).


With Boolean Modeling and Modeling 
for Mesh output, it is useful to consider 
several classes of those Primitives and 
arrangements:


• Standard Primitives
• Custom Primitives
• Boolean Clusters
• Bot Forms


Standard Primitives
GroBoto’s set of basic Primitives types 
— Cone, Ellipsoid, Box, etc. are found in 
the Library Panel to the right of 
GroBoto’s Workspace.


Each has a set of editable parameters 
(like length, radius, etc.), appropriate to 
their type. ese parameters are edited 
with the Reshape controls in the Edit 
Panel just below GroBoto’s Workspace.


Custom Primitives
GroBoto’s Library also contains a few 
Custom Primitives. ese are actually 


Boolean Clusters (a combination of two 
or more Simple Primitives, see below). 
ey may be moved rotated and scaled 
just like Standard Primitives. However, 
they do not have Reshape Parameters. 
Outside of proportional scaling, 
reshaping must be done by editing their 
Boolean Cluster elements.


Boolean Clusters
Boolean Clusters are collections of 
Standard Primitives intersected to create 
more complex & varied forms. Surfaces 
of one or more Standard Primitives trim 
away the volumes of others.


As mentioned above, GroBoto comes 
with a few pre-defined Boolean Cluster 
Primitives. However, the real power of 
Boolean Modeling comes from creating 
your own Boolean forms. Creation and 
editing of Boolean Clusters occurs 
dynamically within the Workspace. As 
you reshape and trim the form, you see 
precisely how it interacts with your 
complete model.
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GroBoto has many tools for arranging 
Primitives from basic Move, Rotate & 
Reshape tools to various Snap & Align 
options to the Flex Tools (which work on  
selections using a ‘range of influence’, 
that fades their effect over distance).


Bot Forms
As all Version 2 users know, GroBoto 
also has ‘Bots’, algorithmic tools that 
create a virtually infinite variety of 
complex forms consisting of many 
Primitives. Bots are throughly covered in 
their own section of this document. 


Bots tend to ‘do their own thing’, often 
used as the sole tool for creating a model 
or image. ey also have a place in 
general modeling and mesh generation.


Modeling Workflow & 
Performance Notes
Groboto allows you to work in real-time 
with very high quality rendering. 
Boolean modeling puts an extra load on 
the system, and uses special display 


features and highlighting. It’s best to 
keep a ‘lean’ workspace when Modeling 
with Booleans. Here are some tips:


• Use only 1 Distant, Shadow Casting 
Light (or turn Shadows off). or...


• Use QuickLine Render Mode for 
more fluid editing. Especially with 
complex Booleans.


• Use only GroBoto’s ‘Simple’ 
Textures (those without Color or 
Bump Maps).


 
Modeling Wrap-Up
You can create great models & images 
straight out of GroBoto with this 
combination of Simple Primitives and 
Boolean Clusters. Enhancing those 
Models with GroBoto’s SeamNet Mesh 
Export options, opens your creations up 
to the entire world of other 3D 
applications for further modeling, 
sculpting and/or rendering. 


More Information:


Standard Primitives
This Document
Geometric Objects & Primitives
Online Docs & Video
Modeling Basics
Modeling Videos


Boolean Clusters
Online Docs & Video
Boolean Basics
Boolean Creation & Editing Videos


Bots
This Document
Bot Creation & Editing
Online Docs & Video
Bot-to-Mesh-to-Sculpt Videos


Next: How all of this relates to 
GroBoto SeamNet Meshes...
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Modeling for Mesh creation


GroBoto can automatically generate a mesh from almost* any arrangement of 
Primitives. is is creatively very liberating — freeing you from the need to constantly 
consider meshing issues as you model & design.


at said, there are a few things you can keep in mind that will help GroBoto produce 
the best mesh for your needs.


Start with Something Simple
While it may be tempting to just run a complex Bot and try meshing it — it’s not the 
best way to Start. Please try something simple, or play with one of the sample files 
first. at way you will get a good look at how the various Smoothing and Styling 
options effect the mesh. 


Starting with something simple is also a good way to get a feel for the three Mesh 
Density Options as well as custom per-object density setting (see Control Density 
below).


Control Density
GroBoto has three modes for distributing Mesh Densities throughout your model. 
Controlling Density Distribution is critical to getting good meshes. e Online Docs 
& Video linked below offer tips & details.


Use Smoothing
GroBoto’s Smoothing and Styling Options often have the pleasant side effect of 
making a cleaner mesh. at is because they ‘Relax’ the mesh and free it from having 
to resolve sharp angles and tight spots in the seam network. Unless you really need/
want a razor sharp mesh that precisely tracks the original Primitive intersections and 
edges, we suggest you try Smoothing (even a very small amount can help, and almost 
always leads to a more sophisticated and elegant mesh).


Online Docs & Video
Mesh Creation Overview & Tips
Mesh Creation Interface
Modeling Videos (that include meshing)
Mesh Output Notes (PDF)


*We say ‘Almost’, because of: 
• A few GroBoto Primitive types that are not supported. 
• Some practical limits to polygon count and memory. 
• A couple of known issues. 


In nearly every case, tweaking a models mesh settings and/or configuration will allow 
the Mesh Engine to do its job. e various Online Docs & Video linked above provide 
detailed information.
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http://www.groboto.com/v3/Documentation/ToolsMethods/MeshCreation/
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Getting Started with Bots
   (Really, really quickly)


Wouldn’t you rather be creating 
than reading this manual?
If so, please trust us. ere is plenty of vital 
information in this manual — and eventually 
you’ll need to poke around. However, you 
can start creating beautiful imagery right 
away if you just dive in, explore, play.


ere a few demos & tutorials online:
www.GroBoto.com
...and we encourage you to try them — but this 
section will get you started even quicker. You 
may not learn that much, but you’ll experience 
the heart, soul & jiggly brain of GroBoto.


This section contains 3 step-by-step examples:


AutoBot Exploration


DrawBot Scribble


Kinetic Morph
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AutoBot Exploration
AutoBots are instant gratification. 


Set Up
Launch GroBoto
-or- (if it’s already running)
Select Reset Document from the Edit Menu


1. Load the Lattice-Zmirr AutoBot
A. Open the Bot Panel
B. Select the Lattice-Zmirr-Auto Bot from the menu (it’s 


found in the Auto > Lattice Auto Presets folder).


2. Seed the Bot
A. Select the Bot Tool (from the Edit Panel found at the 


bottom of the GroBoto window), & click once in the center 
of the Workspace


3. Explore
A. Try adjusting the Inherit Curl or Twist sliders (in the Bot 


Panel -- you may need to scroll down in the Bot Panel to 
see them).


B. Try the Root or Tip Branching sliders


Play More...
• Change the Gradient
• Change the Texture
• Change Bot Shapes
• Try other Sliders


Learn More (links to detailed info)...
• Bot Section
• AutoBot Section
• Gradient Editor
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DrawBot Scribble
Fill the screen with elegant doodles.


 
Set Up
Launch GroBoto
-or- (if it’s already running)
Select Reset Document from the Edit Menu 


1. Load the Blue Arcs DrawBot
A. Open the Bot Panel
B. Select the Blue Arcs Bot from the menu. (it’s found in the 


RingSculpt Draw Presets folder).


2. Start Drawing
A. Select the Bot Tool (from the Edit Panel found at the 


bottom of the GroBoto window).
B. Click and hold down the mouse button near the center of 


the Workspace


3. Keep Drawing
A. Place the cursor over any of the just created objects and 


click again — this time holding down the mouse button and 
dragging along the objects you just added to the scene.


Play More...
• Change the Gradient
• Change the Texture
• Try different Bot Shapes
• Play with the Bot Settings


Learn More (links to detailed info)...
• Bot Section
• DrawBot Section
• Gradient Editor


G
et


ti
n


g
 S


ta
r


te
d


11


1a


1b


2a


3a







Kinetic Morph
Fluid, mysterious, and oddball motion and metamorphosis.


Set Up
Launch GroBoto
-or- (if it’s already running)
Select Reset Document from the Edit Menu 


1. Fill the Animate Panel
A. Click the Animate Button
B. Drag three copies of the PinWheel AutoBot from the 


Library into the Animation Panel.


2. Change the settings of a Bot
A. Select the middle Bot
B. Change the New Branch Angle Slider to  55. is is one 


of the Bot Settings Sliders, found at the bottom of the 
Bot Panel — you may need to scroll down in the Bot 
Panel to see it.
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3. Switch to Parameter morphing
A. Open the Morph Settings Panel
B. Click the Bot Settings Button for each “Morph Pair”. 


is animation has two pairs — one that morphs 
from Bot 1 to Bot 2, and one from Bot 2 to Bot 3. 
Use the Up/Down arrows below the miniature to 
show and edit the settings for each pair.


4. Run a  preview
A. Click the Preview Button


Play More...
• Add more Keyframes
• Move the Camera and/or lights
• Change more Bot &/or Morph Panel Sliders
• Render your animation as a movie.


Learn More (links to detailed info)...
• AutoBot Section
• Animation Section
• Animation Panel
• Morph Panel
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GroBoto concepts
the way things work in groBoville


In this section we talk broadly & briefly about how GroBoto works, and its core 
elements. We also take a quick look at some of its most unique tools. Please see 
the Main Features and Reference sections for more detailed information.


The GroBoto Idea
GroBoto is a different 3D tool. Whether 
you’re a deep roasted 3D graphics pro or 
entirely new to the game, you’ll need to 
get oriented to our world... and forget 
much of what you know about 3D tools. 
is is not quite like anything you’ve 
used before.


Above all we encourage you to Play. 


GroBoto is more Exploration & 
Discovery than Planning & 
Construction. You can do the latter, but 
you’ll be missing out on most of 
GroBoto’s power & fun if you skip the 
former.


ere are plenty of basic tools for 
editing, tweaking, and refining your 
scene, but our unique tools — like Bots 
— will create wonderful richness and 
complexity with ease...  stuff that will 


kick your brain into gear, inspire you, 
surprise you.


The GroBoto Environment
ere are six basic GroBoto elements — 
the things that make up your scene.


• Simple Geometry (objects)
• Compound (Bot) Geometry
• Textures
• Lights
• Camera
• Fog


Textures, Lights, Camera & Fog are 
pretty straightforward, ‘tho each has its 
unique qualities. Geometry can be as 
simple as a sphere, and as complex as an 
editable, morphing AutoBot. 
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GroBoto is 
unlike many 
3D tools. It’s 
important 
that you get 
familiar with 
a few core 
concepts.


A sample 
GroBoto 
Camera view 
featuring Fog 
and  the other 
basic Scene 
Elements.


Distant Light Widget


Static Objects 
with Textures


Local Light Widget


AutoBot Geometry







GroBoto Geometry 


ere are several types of geometric 
entities in GroBoto:


Static Objects - An object or 
group of objects that can be edited, but 
not animated. is type is created by 
dragging primitive shapes into the scene, 
or by drawing with a DrawBot (see Bots 
or Objects Sections).


AutoBot Geometry - A 
group of geometric shapes 
created by drawing in the 
Workspace with the Bot Tool, 
and controlled by an 
AutoBot. ese multi-object 
algorithmic forms can be 
moved and rotated as if they 
were a single object. eir 
individual primitive elements 
cannot be edited separately 
— they are “owned” by the 
AutoBot. However, the 


objects can be detached from 
the AutoBot, making them 
fully editable.


Morphing AutoBot 
Geometry - is is the only GroBoto 
geometry that animates (although other 
things like lights, camera and fog can be 
animated). ey are placed in your scene 
by adding them to the Animation Strip 
(a series of AutoBots displayed in the 
Animation Strip, similar to key frames 
or morph targets found in other 3D 
programs.)
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An autoBot form


The three basic 
Geometry types 
are shown in this 
scene: 
• A morphing 


AutoBot (yellow)
• A static AutoBot 


form (double 
spherical shell)


• A simple static 
objects  (the 
‘Saturn’ sphere & 
ring)



%23Objects%20geometric%20primitives

%23Objects%20geometric%20primitives

%23Animate%20Panel

%23Animate%20Panel





GroBoto Tools
ere are GroBoto tools for creating 
textures, manipulating lights, fog, 
cameras — and all of them are a bit 
unique. But the most unique are the 
modeling and animation tools. At the 
root of  those tools are Bots...


ere are two basic Bot types:


Draw Bots - “Freehand” semi-
automated drawing tools. You control 
some aspects of their application, but 
they have ideas of their own. ey are 
skill-based tools — easy to use, but the 
more you play, the more you’ll get out of 
them. Some create complex branching 
forms composed of hundreds of 
individual objects, others simply add or 
connect new objects one at a time.


e geometry created by DrawBots 
retain some knowledge of how it was 
built, allowing for interaction with other 
DrawBots. However, the individual 
objects they create are fully independent 
and editable.


AutoBots - Fully automated 
algorithmic forms. Once an AutoBot is 
“seeded” (added to the scene by clicking 
in the Workspace), it is edited by 
changing its settings using sliders, 
buttons and such. e final form is a 


single entity that is always under the 
control of the Bot.


GroBoto Folders, Files & the 
Library


For easy access GroBoto keeps track of 
all of its files stored in your GroBoto 
Folder...


MAC: Home > Documents > GroBoto
WIN: My Documents > Braid > GroBoto


... it contains six sub-folders: Bots, 
Gradients, Maps, Primitives, Scenes, and 
Textures.


We highly recommend that you save all 
of your GroBoto files in the appropriate 
GroBoto folder for easy access. e 
Library and the various pop-up menus 
are automatically kept in sync with the 
contents of these folders.


Important Note:
On both Mac & Windows, GroBoto may 
not detect deletion of folders. Please do 
not delete the GroBoto folder, or any of 
its sub-folders while GroBoto is 
running. is can lead to serious 
problems. Instead, quit GroBoto, delete 
the folders, and re-launch.
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GroBoto concepts
Unique Tools


Some of our tools work in ways you might not expect. In some cases we are 
taking advantage of our fast-full-rendering. In other cases our unique 3D 
geometry and environment simply require a somewhat different approach. 
In every case our goal is to make your creative experience fast, fluid & 
rewarding.


Dynamic Color Editing
Dragging the Backdrop/Fog or Object Color
When you drag and drop a color onto an Object or an empty area of your scene, it 
triggers a special “Mouse Up” color editing mode — at is, once you drop, 


editing takes place by moving the mouse 
without pressing the mouse button. e 
scene will update in real time until you 
click again.


 You will see this cursor when you are 
in this Mouse-Up color editing mode. It’s 
“trapped” in an invisible box in the 
workspace (represented by the orange 
bordered box above - although only the 
special cursor will appear on your 
screen).


Moving the cursor within that box 
changes the brightness (vertical position 
within the box) and saturation 


(horizontal position within the box). Your 
scroll wheel changes the hue (or Up/Down 
keys). 


e cursor moves in a 2-D Brightness/
Saturation color space, while you scroll through 


Hues.
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Our Tools are 
often controlled 
in new as well as 
traditional ways.  
Here are a few 
important 
examples.


=
Brightness


Saturation


(Scroll Wheel or Up/Down 
Arrow keys for Hue)


Figure 1







 Drag & Set Tools
You know about Drag & Drop, but this 
is slightly different. With Drag & Set, 
an icon is dragged from the interface 
into the scene. It reads something from 
the surface you drop it on, and relays 
that info back to the interface.


 In this example, the Distance 
setting of a Local Falloff light is set by 
dropping the Drop Set Distance icon on 
a surface of the model.


Scalable Sliders
Sliders are convenient. However, when editing values that have a lot of range and 
require high accuracy, a normal slider won’t do the job. Some of GroBoto’s features 
need both great range and high accuracy — especially Bot settings. In those cases we 
use “Scalable Sliders”.  ey provide this combo of range & accuracy in two ways:


• A user-selectable accuracy setting.
• Auto scrolling providing access to the full range, even with accuracy high.


In figure 3, you see the same slider set to three different levels of accuracy. Set the 
accuracy with the control on the right side of the slider (PC -numeric stepper, Mac - 
ree-Bar toggle).
Figure 3a shows the lowest accuracy for this slider (1) — dragging from one end to the 
other covers the full range (+/- 50 in this example).
Figure 3b shows the accuracy set to 0.1.
Figure 3c shows the accuracy set to 0.01.


With the higher accuracies, the slider only represents a fraction 
of the total range — its like a window zoomed into a portion of 
the full range (fig. 4). When you drag beyond either end of the 
slider, that window automatically scrolls to cover a portion of 
the full range near the value you’ve set (fig. 4).


Note: the “thumb” button snaps back to the center if you finish 
near the end of a slider with high accuracy settings — giving 
you more room for your next edit.


Important Note: Because of the zoomed-in effect with higher accuracy, the button’s 
location does not represent where the current value is relative to the full range. e 
button might be in the middle of the slider bar even though its value is 90% of the 
maximum value of the setting it controls.
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Figure 2


Figure 3


A


B


C


-50 +50


Figure 4







Selecting Objects
e Select Tool selects Objects, Bots and Light Widgets for editing. Our version of 
this tool is not especially unique, but there are a couple of things to keep in mind:


Extent of Lasso Selections
Any objects touched by the lasso are selected (you don’t need to enclose 
the entire object).


What you see is what you select
e lasso selection only selects visible objects. If objects are hidden 
behind others and completely obscured, they will not be selected. If, for 
example, you want to clear a very dense cluster of objects by selecting and 
deleting, you may need more than one pass to get everything. 


Note that often, such dense 
clusters can be easily selected 
if they were created by a Bot 
or placed in a group using the 
Select By options at the 
bottom of the GroBoto 
window.
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groBoTip
The select tool can 
be used either as a 
simple click selector 
or a lasso. It’s auto-
matic -- if you click, 
it selects, if you drag 
it lassos.


Selection Types
These allow you to select by various types (select all objects with 
same texture, in the same group, etc.) The ‘Branch’ and ‘Bot’ types 
select structures or substructures (groups of objects that go to-
gether) created by Bots.


Highlighting
The selected objects get a yellow 
highlight.







Main Features
Objects • Bots • Lights • Camera • Textures • Scene • Animation


In this section GroBoto’s main 
features are discussed in detail:
• Objects
• Bots
• Animation 
• Lights
• Camera
• Textures
• Scene (Render Modes etc.)


You don’t need to know all of this stuff to 
get started with GroBoto. Underneath 
GroBoto’s fast and easy toolset is a good 
amount of depth and substance. After 
you’ve explored for a while, you will want 
to know how to take your work farther... 
to refine it. is section will help. It offers 


a dose of “why” along with “what & how” 
— there are good reasons for our 
implementation of these features. Your 
understanding of both the strengths & 
quirks of GroBoto will increase your 
enjoyment & capabilities.


You will also find that GroBoto’s ease in 
creating great complexity and detail — in 
almost no time — will tempt you to push 
the limits of your computer. GroBoto can 
deliver this complexity, but every system 
has its limits. e information in this 
section will help you get the most from 
yours.
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Objects geometric primitives


Building blocks
Groboto’s simple shapes serve as building blocks for its complex Bot forms — but they 


are pretty interesting on their own. ey are procedural shapes — mathematically 
defined, not polygonal meshes. eir surfaces are perfectly smooth no matter how 
closely you look, or how high-resolution the rendering. is precise geometry also 


insures that those Bot forms — with all of their intricate intersections — are 
beautifully and faithfully produced.


Adding & Removing Objects 
ere are three ways Objects are added to your Scene:


• Dragged & Dropped from the Library
• Pasted from the Clipboard
• Generated by a Bot


Dropped objects are automatically selected, and the selection is locked. 
is is important because you may not see the dropped object (for 
example, if there is heavy fog or the object is very small). With the 
selection locked you have the chance to Move, Reshape, or add the 
object to a named group without needing to click on it. 


 Any selection of objects in your scene can be Copied or Cut, placing it 
on the clipboard, and then pasted Pasted. Pasted objects are also 
selected and locked. See the Cut, Copy & Paste reference section for 
details.


Bot-generated objects are a whole other story. Bots create (sometimes 
vast), arrays of organized objects in a variety of ways. Please see the Bots 
Section for details.


Removing Objects from your Scene
It’s as simple as selecting, and hitting the Delete key. But there are some 
exceptions:


Objects belonging to an AutoBot that is part of a Morph Sequence can 
not be deleted. e Bot itself can be deleted from the Animation Strip, 
but as long as there are any Morph Keys present, their objects will exist 
in your scene. Only when the entire Animation Strip is cleared, will the 
AutoBot generated objects be removed. See the Animation Panel 
Reference for details.
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v3 Notes:
The introduction of Custom 
Booleans has greatly enhanced 
GroBoto’s Modeling range.


Many new tools and features 
have been added to take 
advantage of this new capability.


This Document does not cover 
any of these new Modeling 
Features. Here are links to 
relevant web pages and other 
resources that do:


Custom Boolean Videos
Modeling Videos
Custom Booleans
Flex Tools
www.groboto.com/v3docs



http://www.groboto.com/v3/Documentation/TVideos/BooleanVideo/

http://www.groboto.com/v3/Documentation/TVideos/BooleanVideo/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/ToolsMethods/BooleanModeling/

http://www.groboto.com/v3/Documentation/ToolsMethods/BooleanModeling/

http://www.groboto.com/v3/Documentation/ToolsMethods/Modeling%20Basics/

http://www.groboto.com/v3/Documentation/ToolsMethods/Modeling%20Basics/

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs





Reshaping Objects
Groboto’s shapes each have a number 
of editable parameters. With simple 


objects these parameters are obvious 
(e.g. a Cylinder has Length & Radius). 


Other shapes like the “HyperRod” (fig. 
1, eight variations of a HyperRod) have more 


parameters and can take on a much greater variety of 
forms. A number of presets of each shape is included in the Library.


Reshape an object by first selecting it, then selecting one of its 
parameters in the Edit Panel (fig. 2). is list of parameters 
changes depending on which object type(s) are selected. If your 
selection contains multiple shape types, only [Scale Local] will 
be available.


e Global Scale item (just to the left of the individual object 
parameters in the Edit Panel) Scales a group of objects as a 
group. at is, the relationship between objects is maintained 


— they are scaled as a unit. e [Scale Local] item, when 
used with multiple objects, scales them each locally (see 
fig. 3,).


Like most of the tools in the Edit panel, these Object 
parameter and Scaling controls can be used in either of 
two ways:


1. Click and drag directly on the control.
2. Select the control, then click & drag on an object in 


the Workspace.


Each has its advantages. See the Edit Panel Reference for details.


When used by a Bot, the shape can gradually transition from one parameter set to 
another. Please see the Bots Section for details.
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Figure 1


Figure 2


Figure 3


A. Original
B. Scaled Globally


C. Scaled Locally


A       B            C







Objects, properties, Textures, & groups
ere are several things associated with each GroBoto Object. ey 
can be divided into three types:


1. Object Properties
2. ings assigned to an object (like Textures)
3. ings an object belongs to (like a group or a Bot)


ese are all managed in the Selection & Group Options Panel.


Properties
In addition to its shape type (Sphere, Cone, Cylinder etc. — and the 
parameters that define that shape — see above), each GroBoto object 
has two other editable properties.


• Color (often referred to as base color in this document)
• Tintability (whether or not the base color tints textures)


Objects & Textures
Textures are not object properties — they do not belong to the object. 
ey are an independent element of your scene. Many unrelated ob-
jects may use the same Texture — change the Texture, and the appear-
ance of all those objects will change. See the Textures Section.


Groups
Objects may be placed in named Groups. ere is just one (perma-
nent), group when you start GroBoto — with the special name “[De-
fault]”. You can create named groups and place your objects in those 


groups. Later, those objects can be se-
lected and manipulated as a group using 
the Select by Group checkbox in the edit 
panel. See Selections & Groups.


New objects added to the scene by drag 
& drop from the Library, or pasting, are 
always put in the default group. If there 
are multiple objects in your drop or 
paste, you will be prompted to place 


them in a group... this is optional, but often sensible given that you likely will want to 
select & manipulate that same batch of objects later.


Note that arrangements of objects created by Bots are automatically grouped — but 
not in the named groups mentioned above. Instead, they are either:


• Entirely controlled by the Bot, if created by an AutoBot.
• Grouped into “Branches” if created by a DrawBot. 


Bot created objects can be selected and manipulated as a group using the Select by 
Bot or Select By Branch checkboxes in the Edit Panel (see the Bots Section & Edit 
Panel Reference for more details).
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Selection Options.







Objects & Bots
Bots use GroBoto’s simple primitives as building blocks. e best information on their 
use is found in the Bots Section and Bot Panel Reference.... but here are a couple of 
notes:


Bot A & B objects
All Bots use two shapes — referred to as the “A” and “B” shapes. Some 
Bots require that the A & B objects be the same type, both cylinders for 
example. ose Bots then transition from the A object to the B object 
according to their internal rules. So if object A was a short disk-like cyl-
inder, and Object B a long narrow cylinder. the Bot might contain all of 
the cylinder variations in-between (fig. 5)


Other Bots allow A & B to be different object types, say, a cylinder and a 
ring. In those cases, there is no transitioning between A & B, rather the 
two objects are simply designated to play a certain “role” in the Bot’s 
construction — like rings for “hubs” and cylinders for “spokes” (fig. 6).


e Bot Object Editor (part of the Bot Panel - inset in both fig. 5 & 6), has tools for 
reshaping, scaling and rotating the objects.


Detaching Objects from AutoBots
AutoBots “own” their objects. e individual primitives are part of a dy-
namic system (the Bot), that is constantly being created and destroyed dur-
ing the Bot editing process. So, you can’t individually edit or modify ob-
jects belonging to an AutoBot. However, objects created by an AutoBot 
can be detached from it —making them fully editable. Either:


•  Use the Workspace Context Menu (right-click on any object belong-
ing to the Bot), and select Detach Objects from AutoBot.


• Select the AutoBot’s objects with the Select Tool, and the choose Edit 
> Detach AutoBot Objects from the Edit Menu.


Note: Once detached, the objects will no longer be editable by the Bot.
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Figure 5


Figure 6







Bots
Bots are GroBoto’s heart & soul & little-mote-of-a-
brain. ere are two basic Bot types — DrawBots 
& AutoBots. ‘o they have much in common, 
there is a fundamental difference: 


DrawBots are drawing tools — ey are used to 
add interesting arrays of objects to your scene. 
Objects created by a DrawBot are just objects.


AutoBots are dynamic editable systems — e 
objects they create are “owned” by the AutoBot — 
they can only be edited by changing the AutoBot’s 
settings.


DrawBots - “Freehand” semi-automated drawing 
tools. You control some aspects of their application, 
but they have ideas of their own. ey are skill-based 
tools — easy to use, but the more you play, the more 
you’ll get out of them. Some create complex 
branching forms composed of hundreds of individual 
objects, others simply add or connect new objects one 
at a time.


Geometry created by DrawBots retains some 
knowledge of how it was built, allowing for 
interaction with other DrawBots. However, the 
individual objects they create are fully independent 
and editable.


AutoBots - Fully automated algorithmic forms. 
Once an AutoBot is “seeded” (added to the scene by 


clicking in the Workspace), it is edited by changing its settings using sliders, buttons 
and such. e final form is a single entity that is always under the control of the Bot. 
You can move or rotate the entire AutoBot form as a whole, but you can’t edit its 
individual primitives 


e primitives can be detached from the AutoBot, making them fully editable (see the 
Objects Section — Detaching Objects from AutoBots). Of course, once detached they 
are no longer editable by the AutoBot.


AutoBots are the only animateable Bots. ey can be added to the Animation Strip to 
create GroBoto’s  kinetic morphs. (see the Animation Section)
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Bot Panel Overview
AutoBots & DrawBots are both controlled with the Bot Op-
tions Panel. When a Bot is loaded, (selected from the Library, 
or from the “Bots” pop-up in this panel), it fills out all of the set-
tings seen here.


e Panel is divided into three sections:
• Bot Global Settings
• Bot Objects & Texture
• Bot Controls


Bot Global Settings 
is section of the Bot Options panel contains general settings 
common to most Bots:


• Adjusting the drawing speed for DrawBots.
• Resetting the Bots originally loaded settings.
• e number of objects the Bot generates.
• Overall scale of the Bot.
• Object scale relative to the Bot’s scale.
• Mirroring,
• A:B scaling modifiers (amplifying & skewing).
• Step Size (object spacing).


Note: BuildBots (see BuildBots below), have some different settings 
in this section.


Bot Objects & Texture 
is section of the Bot Options panel contains controls for the two 
objects (or primitives), used by the Bot to construct its form:


• Setting the Bot’s A:B draw objects.
• Edit controls for reshaping and rotating the A & B objects.
• Texture and color pickers.
• Duct controls for AutoBots.
• B object scale parameter.
• e Fixed Rotation checkbox.


Bot Controls
is section of the Bot Options panel contains controls for the 
unique settings for each Bot:


When loaded, each Bot fills out a list of sliders in this section. ese sliders are unique 
to its core type (i.e. all ringSculpt presets have the same slider set).


Important Note: Most of the sliders in the Bot Panel are GroBoto’s special Scalable 
Sliders. You need to know how the work to get the most from your Bots. See the 
Unique Tools - Scalable Sliders section for details.


All of these controls are explored in more detail at the end of this Bots section. See 
Bot Panel Details below.
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DrawBots
DrawBots create geometry by clicking the mouse on a 
point in space or (more often) clicking on an existing 
object and holding down the mouse while the Bot creates 
a branch or series of objects. e Bot inherits information 
like starting size, color, and orientation from the clicked-
on object. So, DrawBots are relational in this way. Note 
that in most cases, the most interesting drawing is 
accomplished by starting a branch on objects created 
with the same DrawBot (*with the exception of a special 
DrawBot called the “BuildBot” described later in this 
section).


Cursor Object & the Touched Object
When a DrawBot is active, and the cursor is in the 
Workspace, GroBoto draws a “cursor object”.  is is a 
preview of the first object the DrawBot will create. Many 
DrawBots snap the cursor object to a location near the any 
object you touch – especially one created by the same Bot. 
e Bot scales, synchronizes or joins to the touched 
object in a relational way. For example, at right angles.


Starting Location of a new DrawBot 
Most of your DrawBot drawing will involve adding objects or branches to your 
DrawBot form — but you have to start somewhere. You can simply click in empty 
space, or, use the scrollwheel to position the cursor object relative to an existing 
object. is is useful for starting your drawing relative to a large background object 
like a large flat ellipsoid or box. is works only if the cursor is not over an object 
created by the same Bot.


Using the ScrollWheel to Position a DrawBot
With a DrawBot selected and mouse up, position the mouse cursor over an 
existing object (for practice try a large object — we provide several built in 
“Stage” objects). Use your scrollwheel to offset the cursor object position. 
e object will move perpendicular to the surface you are over.
When you are satisfied with the cursor object location, hold down the 
mouse to start drawing.


Note this scrollwheel functionality applies to all DrawBots except the 
BuildBot which uses the scroll wheel for a different purpose – see the 
BuildBot description later in this document.


DrawBot Parameters
DrawBots have a number of configurable settings or parameters, defining 
how they create geometry. Edit these settings with a series of sliders and 
other controls in the Bot panel (fig, 1). ese include things like how fast a 
branch curls or how frequently it creates new branches as you hold down 


the mouse. ese parameters will be saved with the GroBoto scene file, and you can 
save the Bot as a preset to be used in any scene.
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groBoTip
We highly recommend a 
mouse with two buttons 
and a scrollwheel. How-
ever, the Up/Down Arrow 
Keys can be used for all 
scrollwhell operations. 
Control-Click works as 
right-click on Macs with a 
one-button mouse.







Editing & Saving DrawBots 
A single DrawBot, like ringSculpt, can produce a wide variety of forms 
depending on its parameters. We’ve included a few examples of each 
DrawBot, but the possible variations are endless. You’ll want to create 
and save your own.


Use a scratch scene — an empty scene that you don’t intend to save –  to 
experiment. Adjust Bot parameters and draw sample branches. When 
you have something interesting, click the Save… button in the Bot panel. 
Save your Bot to your GroBoto/Bots directory (or some subdirectory 
therein) to automatically add it to the Bot selection drop-down menu & 
your Library. GroBoto defaults to the Bots folder when you click the Save 
button.


Mirroring
Play with different mirror settings to add complexity and symmetry with 
DrawBots. A mirrored DrawBot generates sets of symmetric branches. 
e Bot Mirrors setting in the Bot Options panel specifies which World 
space axis or axes (X, Y, Z or combination) are mirrored. Enable the 
World Axes (button in the Edit/Animate Panel), to see how the branches 
will be mirrored.


Lock Mirror
DrawBot mirroring is mostly automatic. e first time you draw with a 
mirrored DrawBot, it sets the mirror point equal to the Bot’s starting 
location and locks it (as shown by the Lock Mirror toggle in the Edit 
panel). All subsequent branches will be created around this point. You 
can establish a new mirror point by un-checking the Lock Mirror toggle 
button — the next click will set and lock a new mirror point. 


DrawBot A:B Objects
A DrawBot builds its forms with pair of simple objects (the “A” and “B” 
object). DrawBots either interpolate or alternate between A and B as they 
draw. ese objects are displayed and configured in the Bot Objects & 
Texture section of the Bot Options panel. e A:B object configuration is 


saved when you save a Bot (and when the Bot is saved with the GroBoto file).


DrawBot Color & Texture
e Bot Objects & Texture section controls the texture and colors for a DrawBot’s 
objects. You can assign either solid colors or a gradient. Check the Texture Tintable 
checkbox to have textured objects tinted by the selected color option (either solid 
color or gradient). 


You can subsequently edit the color, gradient, texture, or tintability for DrawBot 
objects by selecting them in the scene and using the edit controls in the Selections & 
Groups panel.
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Figure 1







Object B Scale Control
e Object B Scale slider in the Bot Objects & Texture panel 
scales the size of the B object relative to object A. is is handy 
for making Bot branches taper — you may want the tip of a 
branch to be 100 times smaller than the root (or 1% of the 
root). It is impractical to work with such a tiny object in this 
Bot Object editor because the A & B views use the same 
camera.  


Duct Conversion
Most of the DrawBots create branches that can optionally be 
converted into Ducts, curved sections of smooth pipe-like 
objects joined by ellipsoidal joint objects. ere are two flavors 
of Ducts: Flat and Round. As the names suggest one creates 
flattened pipe shapes, the other, round. e conversion to 
Ducts inherits the source object’s thickness along the branch 
approximating the original shape. 


To convert one or more branches to Ducts, do the following: 


• Draw one or more branches with a DrawBot (a good one to experiment 
with Ducts is the RingSculpt Bot).


• Choose the Select tool from the Edit panel. 
• In the Edit panel, enable Select by Branch. Click on a branch to select it 


or Shift+Click to select several.
• Go to the Object Properties panel and the Duct Conversion sub-panel. 
• Select the type of Duct (Flat or Round), the number of objects along the 


branch per Duct (e.g., 4 would mean for every 4 object along the branch, 
one Duct will be produced), and then click Convert Selection.


• is operation is undoable, so you can play with the Duct conversion 
settings repeating the previous step as desired.


Not all DrawBots produce ductable branches. e Convert Selection button 
will only be enabled if GroBoto is able to convert the selection into a 
sequence of Duct objects.


Note: AutoBots have their own Duct conversion settings in the Bot Options 
panel. An entire AutoBot instance can be drawn with Ducts. However, if an 
AutoBot’s geometry was detached (see Detaching AutoBot Geometry below), 
then its branches will be individually ductable. Note however that like some 
DrawBots, not all AutoBots create branches that can be converted to ducts. 
You will always know if Duct conversion is possible by seeing if the Convert 


Selection button is enabled for any current selection of objects.
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Duct 
Conversion


Before:


After:







Built-In DrawBots
Below is a description of each of the built-in DrawBots. DrawBots come in three 
flavors. ese flavors have common behaviors and controls, but each is used 
somewhat differently — the flavors are:
1. Sprouting
2. Chasing
3. Building


Below are the built in Bots... a general description of the operation of 
each flavor is followed by individual Bot descriptions for DrawBots of 
that flavor:


Sprouting DrawBots
ese Bots create branches or other arrays of objects — with most Sprouting 
DrawBots, dragging across any other Bot generated objects causes the Bot to 
“jump” to the location of that touched object and generate new “sprouts”. Some 
Sprouting DrawBots also sprout spontaneously (even when you don’t move the 
mouse over new objects) — periodically jumping to new locations on existing 
branches. Sprouting DrawBots do not react to non-Bot objects (for example 
objects you dragged in from the Library). is allows you to freely drag around 
your scene without accidentally creating sprouts on unrelated objects.


FanBranch (Flavor: Sprouting)
is Bot creates a series of fan-like object arrays with the A object at the center of 
each wheel, and radiating B objects. Additional fans spontaneously sprout as you hold 
down the mouse, or drag the mouse over other objects. e default Bot has a cylinder 
as the A object and an elongated HyperRod as the B object. ere are a number of 
parameters to play with, and try changing the Fan Angle, Fan Radius, and Tilt to get a 
quick feel for how this Bot can be adjusted. 


FanSimple (Flavor: Sprouting)
is Bot is similar to FanBranch but creates just a single fan pattern with each press 
and hold of the mouse. ere is no spontaneous sprouting - ‘tho you can build up 
complex patterns with repeated clicks. Each radial object (or spoke — the B object) is 
a good place to attach more fans. Clicking on those spokes creates linked structures 
and expanded patterns. ere are a number of parameters to play with to get different 
fan sizes, angles and patterns, and remember to save these as presets. 


LatticeDraw (Flavor: Sprouting)
is Bot creates a lattice of objects along variably scaled and oriented spirals. Simply 
press and hold the mouse down to start a new branch (spontaneous branching will 
occur if you hold down and don’t drag). You can start branches on existing branches, 
creating more complicated structures, or drag across existing branches. is Bot 
inherits the amount of turning (‘curl’) from the objects you touch. You can adjust this 
with the Inherit Curl % slider. Try changing the Starting Curl and Twist parameters to 
get considerable variation in pattern.
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Pipe-Joint (30, 60 & 90) (Flavor: Sprouting)
ese are a bit more structured type of Sprouting Bot. ey alternate between 
creating “Joint Clusters” and straight “Rod” sections. It you click on a Joint you get a 
Rod — click on a Rod, you get a Joint.


Click and hold down the mouse on empty space or some object not created by a Pipe-
Joint Bot. e Bot will create a radial Joint Cluster (using object B) aligned at 30, 60 or 
90 degrees depending on the Pipe-Joint version used.
en click and hold the mouse on one of the joint objects, and the Bot will create a 
straight Rod section using object A. generally it’s not a good idea to drag with these 
Bots — you’ll get incomplete Joint Clusters and erratic forms.


Rig-Draw (Flavor: Sprouting)
is Bot creates a branching structure consisting of planar spiral patterns joined by 
perpendicular straight branch segments. Simply position the mouse cursor in space or 
over an existing Rig-Draw object, and hold down the mouse to draw (spontaneous 
branching will occur if you hold down and don’t drag — new branches will sprout if 
you drag over existing Rig-Draw objects).  Try changing the two Branching 
parameters for different structure densities. Try some tapering for a more elegant 
form.


Ring Sculpt (Flavor: Sprouting)
is Bot creates one spiraling branch per mouse down (no spontaneous branching), 
however it has several parameters to control how it twists and turns. It has a 
parameter (New Branch Ang) to control the angle at which branches start if you click 
on an existing Ring Sculpt branch. For this reason, this Bot has a lot of variability in 
the forms it creates, and GroBoto includes several interesting presets.


Ring Sculpt Alt/Option Key Control: When branching from an existing object, Ring 
Sculpt branches can start from one of two points on the clicked on object. Hold down 
the PC:Alt/Mac:Option key when clicking on an existing object to alter which side of 
the object the Ring Sculpt branch starts from. You can also hold down the PC:Alt/
Mac:Option key while positioning the cursor (with mouse up), and the cursor object 
will change to reflect in which direction the branch will start. 


Chasing DrawBots 
ese Bots follow or “chase” the cursor as you drag. When you move the 
mouse, they look at where the mouse is, where they are currently growing, 
and change directions. ey don’t grow directly towards the mouse location 
— rather they pick from a number of possible directions (according to their 
growth patterns). e effect is that you influence the growth direction, not 
control it.
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FollowArc (Flavor: Chasing)
is Bot creates a sequence of straight line segments and arc segments according to 
how you drag the mouse. e basic idea is: When you drag the mouse, the Bot 
changes direction and draws a straight segment — when you pause (still holding down 
the mouse button), an arching segment is drawn — drag the mouse to another 
location and another straight segment grows in that direction.


Using FollowArc:


• Position the cursor on an existing object or point in space, then press the mouse 
down.


• With the mouse down, start moving the cursor in some direction. e Bot 
creates a sequence of A objects (default is cylinder), roughly following your 
mouse movement. (It won’t start drawing until you move an inch or so from 
your click location).


• Keeping the mouse down, pause moving the mouse. is causes the Bot to start 
drawing spirals of objects using the B object (default is cone), with increasing or 
decreasing radius according to the Spiral Curl parameter (positive increasing 
radius, negative decreasing).


• Release the mouse when done. Repeat these steps starting on an existing Bot 
object to create more complex patterns.


is Bot allows you to specify the A and B objects to be of different types (i.e., 
cylinder, sphere, etc).  e A object defines the straight line segments while the B 
object is used for the arc segments.


With this Bot, it’s important to adjust the Speed slider to get the rate of drawing to 
something you like according to how fast you move the mouse and pause to create 
spirals.


FollowPipe (Flavor: Chasing)
This Bot creates a sequence of straight pipe segments using object A (default is 
cylinder) with joints using object B (default is sphere). 


Using FollowPipe:


• Position the cursor on an existing object or point in space, then press the mouse 
down.


• With the mouse down, move the cursor in some direction. e Bot will create a 
straight line sequence of A objects. (It won’t start drawing until you move an 
inch or so from your click location).


• Keeping the mouse down, change the direction of the mouse movement. e Bot 
will create a joint object and start a new pipe section. Do this again and again 
(dragging in different directions) to get an interesting sequence of pipes.


• Release the mouse when done. Repeat these steps starting on an existing object 
if desired. In this case a joint will be created on the starting object location.


With this Bot, it’s important to adjust the Speed slider to get the rate of drawing to 
something you like according to how fast you drag the mouse.
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BuildBots
BuildBots are a type of DrawBot. ey are designed to make relative 
connections and arrangements between objects. ey read the properties of 
the existing objects you touch, and add new objects based on what they’ve 
“learned”. For example matching the touched objects size(s), color, orientation 
etc. 


Built-In BuildBots 
e BuildBot is really many Bots in one. While all DrawBots offer great variety of 
form, the BuildBot actually functions differently depending on its settings. Because of 
that, we suggest you try these presets first before jumping into creating your own 
variants.


Build-OneSurfacePaint (Flavor: Building)
is BuildBot “Paints” objects onto the surface of a single, larger object. Dragging 
across the surface of any object in your scene leaves a trail of objects behind. ese 
new objects sit on the surface of that touched object, and are oriented perpendicular 
to that surface (“standing up”, if you will). ese objects are only placed on the “First 
Object” (the object you click on to start drawing). When you drag off that first object 
(onto empty space, or another object), the Bot stops drawing.


Build-SingleMatch (Flavor: Building)
is BuildBot “Connects” a single new object to the object you click on or drag over 
(the “Touched Object”). e Bot matches the diameter of the new object to the 
Touched Object, while proportionally adjusting the length of the new object. e new 
object matches the orientation of the Touched Object, and snaps to the center of the 
Touched Object (optionally, using the scrollwheel, you can offset the new object along 
its length axis). Since this Bot creates only one object with each touch, as you drag, it 
makes a single attachment to each Touched Object.


Build-multiMatch (Flavor: Building)
is BuildBot is very similar to “Build-SingleMatch” above, with two important 
differences. It creates multiple objects with each touch (if you linger over an object 
while dragging). As this string of new objects grow, the shape of the each new object 
changes. is change is based on the differences between the Bot’s A & B objects. (see 
overview below for more on BuildBots and A:B objects).
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BuildBot Overview
BuildBot’s multi-functionality may make it seem complex — but its main purpose 
is simple: Add new objects to the scene in a way that relates to existing objects.


e notion is... When adding an object, you are often most interested is how it relates 
to other objects in the scene. Its absolute orientation, location, shape, and size don’t 
mean much — what matters is if it’s bigger/smaller/same-sized, above/below/sitting-
on-the-surface-of, another object. BuildBots allow you to automate these relationships 
— especially important in a typical GroBoto scene that may contain thousands of 
individual objects.


Note: As mentioned above, BuildBots are capable of very different behaviors based on 
their settings. We suggest you try the built-in presets described above before trying to 
understand all of the controls and functionality covered here.


In this section we cover all of the settings unique to BuildBots:


BuildBot & Their A:B Objects
Length Matching Options
Diameter Matching Options
Location Options
Alignment Options
Color Options
Draw Touch Filters
Randomize A-B Obj
Randomize Color
Randomize Angle
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BuildBot and their A:B Objects
BuildBots use the A & B objects differently than other DrawBots. 
ere are two relationships to keep in mind:


1. How the A object is matched to the touched object.
2. How the B object relates to the A object.


BuildBots always draw with the B object. 
Differences between the A & B objects are applied each time an object 
is added. 


Here are some A:B object examples...


BuildBot A:B Object - example 1.
In this simple version of a BuildBot (fig. 2) the important settings to 
note are:


Match Length to Length
Match Diameter to Diameter
Start At Object Center
Align to Object Orientation


e “A” & “B” objects shown in fig. 3 
are just for reference — representing 
the A & B objects as defined by this 
BuildBot.


When we touch the scene object (fig 
3B “T”), we get the result (fig 3B “R”), 
a cone that is narrower and taller than 
the touched object. Here’s why:


Behind the scenes, the BuildBot first 
matches its A object to the touched 
object (fig 3B “M”).


Next, the Bot looks at the differences between its A & B object, and 
applies those differences to the matched object (M). In this case the B 
object is about twice as tall, and twice as narrow as the A object... so, 
the resulting object, “R” is about twice as tall and twice as narrow as 
the “M” object.


If the BuildBot’s A & B objects were identical, we would have ended up with the “M” 
object, because there would be no differences to apply after matching.


It’s important to note that there is an offset of 102% (so the resulting cone is placed 
above the cylinder), and that Bot & Object scales (Bot Global Settings), are both 100% 
— if they were anything else they would alter the Matching phase (first the matching 
occurs, then any global scaling applied). If you want true matching, always have Bot 
Scale & Object Scale at 100%.


Next we’ll try the same thing with just two changes...
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Figure 2


Figure 3b
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BuildBot A:B Object - example 2.
In this simple version of a BuildBot (fig. 4) the important settings to 
note are:


Match Length - Proportional (1st difference from example 1 above)
Match Diameter to Diameter
Start At Object Center
Align to Object Orientation


Also note that the Bot’s A & B objects are identical. (2nd difference 
from example 1 above)


e “A” & “B” objects shown in fig. 5 are just for reference — 
representing the A & B objects as defined by this BuildBot.


When we click on each of  the scene objects (fig. 5 - gray cylinders), 
we get the green cones. Here’s why:


e BuildBot first matches its A objects diameter to the touched 
objects diameter.


Next, the Bot proportionally adjusts the new objects height to its 
diameter. Regardless of the 


proportions of the cylinder, we 
always end up with a cone with 
its original proportions, and a 
diameter that matches the 
touched object


Since the BuildBot’s A & B 
objects were identical, there 
were be no differences to apply 
after matching (unlike example 
1 above).


It’s important to note that there 
is an offset of 102% (so the 
resulting cone is placed above 


the cylinder), and that Bot & Object scales (Bot Global Settings), are 
both 100% — if they were anything else they would alter the Matching 


phase (first the matching occurs, then any global scaling applied). If you want true 
matching, always have Bot Bot Scale & Object Scale at 100%.


Next we’ll look at what happens with these A:B Objects when we set the 
BuildBot to create more than one object at a time...


B
o


ts
 • 


B
u


il
d


B
o


ts


36


Figure 4


Figure 5
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BuildBot A:B Object - example 3.
Please see example 1 (above) first... this will all make more sense.
is example shows what happens with this A:B object stuff when we 
set the BuildBot to create more than one object at a time...


In this simple version of a BuildBot (fig. 6) the important settings to 
note are:
Object Count = 20 (previous examples were 1)
Match Length to Length
Match Diameter to Diameter
Start At Object Center
Align to Object Orientation


e “A” & “B” objects shown in figs. 7a & 7b are just for reference — 
representing the A: B objects as defined by this BuildBot.


When we click on each of  the scene objects (fig. 7a & 7b 
- dark gray cylinders), we get the lighter gray cones. 
Here’s why:


Behind the scenes, the BuildBot first matches its A object 
to the touched object.


Next, the Bot looks at the differences between its A & B 
object, and applies those differences to the matched 
object. In this case the B object is slightly longer and 
slightly narrower than the B object... so, the resulting 
objects are each taller & narrower.


e difference between this and examples 1 & 2, is that 
we’ve set the Object Count to 20. When the BuildBot 
count is greater than 1, the BuildBot automatically 


repeats the build operation on each 
subsequent object. So, the first object 
is relative to the original touched 
object, the second is relative to the 
first, third relative to the second, etc. 
(Note: the Bot only draws while the 
mouse is down, so you may get fewer 
objects than set with the Object Count 
Slider).


In 7a, the A:B objects only differ in 
size. In 7b, we have added rotation to 


the B object (as seen in fig. 6)


It’s important to note that there is an offset of 50% (so the resulting cones are each 
moved forward), and that Bot & Object scales (Bot Global Settings), are both 100% — 
if they were anything else they would alter the Matching phase (first the matching 
occurs, then any global scaling applied). If you want true matching, always have Bot 
Bot Scale & Object Scale at 100%.
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Figure 6


Figure 7b
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Object Size Matching Options 
Note: All of the size matching options below are also effected by the Bot Scale and 
Object Scale settings. To keep things simple, keep Bot Scale and Object Scale at 100% 
when learning size matching options.


If Object Count is set to two or more or Unlimited is checked, then each new object 
will base its matching on the previously created object (see A:B Object Example 3 
above).


Length Matching Options
Length to Length: e newly added object’s length matches the length of the touched 
object. 


Length to Main Diameter & Length to Second Diameter: e newly added object’s 
length matches the diameter of the touched object. 


Some objects have two  diameters to choose from. ese include a Cone, HyperRod, 
HyperTube & Torus. If the touched object is not one of these types, the main diameter 
is used regardless of the option selected.


Proportional Length: Selecting this option proportionally maintains the length of the 
new object when one of Diameter matching options is set. See below for the diameter 
matching options.


Diameter Matching Options
Diameter to Main Diameter & Diameter to Second Diameter: e newly added 
object’s diameter matches the diameter of the touched object. 


Some objects have two  diameters to choose from. ese include a Cone, HyperRod, 
HyperTube & Torus. If the touched object is not one of these types, the main diameter 
is used regardless of the option selected.


Proportional Diameter: is option proportionally maintains the diameter of the new 
object when one of the Length matching options is set (see above).


Location Options
Start at Object Center: is creates the first object at the center of the touched object. 
If the Location Offset is not 0, the new object is moved along its length axis. If Object 
Count is set to two or more or Unlimited is checked, then multiple objects will be 
offset from one another according to the Location Offset setting (see A:B Object 
Example 3 above).


Start on Surface: is creates the first object on the surface of the touched object. If 
the Location Offset is not 0, the new object is moved along its length axis. If Object 
Count is set to two or more or Unlimited is checked, then multiple objects will be 
offset from one another according to the Location Offset setting (see A:B Object 
Example 3 above).


Stay on Surface:  Places each newly created objects on the surface of the touched 
object(s). is option ‘paints’ objects on the surfaces of other objects as you drag the 
mouse. If you hold the mouse button down without moving it, all objects will be 
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drawn at the same location. So normally you drag with this option. You have a couple 
of options for specifying which objects the Bot draws on (see Draw Touch Filters 
below).


Alignment Options
Object Orientation: is aligns the first object to the touched object’s orientation. If 
Object Count is set to two or more or Unlimited is checked, then multiple objects will 
be offset from one another according to the Location Offset setting (see A:B Object 
Example 3 above).


Align to Surface: is aligns the first object to the touched object’s surface normal 
(i.e., the perpendicular line to the surface). If Object Count is set to two or more or 
Unlimited is checked, then multiple objects will be offset from one another according 
to the Location Offset setting (see A:B Object Example 3 above).


Color Options
Note: BuildBots draw with their B object — so it’s the B objects color that is used 
whenever the BuildBots color comes into play.


Use Gradient index: is option only works if the touched object was created by a 
Bot. e BuildBot reads the touched objects “Gradient Index” (left-to-right position in  
its gradient), and then uses the color from the same position in its own gradient. If the 
touched object was not created by a Bot, the color defaults to the solid color applied to 
object B in the Bot Objects & Texture section of the Bot Options panel.


Match Object Color: Matches the new object color to the touched object color.


Mix Slow, Medium, Fast: Mixes the touched object color with the solid or gradient 
color of the B object as set in the Bot Objects & Texture section. e Bot starts with 
the touched objects color and gradually mixes in its own color. If using a solid color, 
the mixing interpolates the color of the touched object to the color of object B. is 
option only works with the Start at Object Center, or Start on Surface options, and an 
Object Count of 2 or more.


Draw Touch Filters
It is often useful to restrict where you BuildBot builds. ese options limit which 
existing scene objects the Bot will react to — and therefore, where it builds.
Any Object: As you drag, the Bot will react to any surface you touch, and draw.


1st Object: As you drag, the Bot will only draw on the first object you touched 
— ignoring all others.


1st Object Type: As you drag, the Bot will only draw on objects whose type (cone, 
cylinder, ellipsoid, etc) matches the first object you touched — ignoring all others. 
is is very handy if you wanted to say, place a ring around every sphere in a scene. 
You would start by clicking on one of the spheres, then freely drag with the BuildBot 
— it will only draw when you touch a sphere.


Randomize A-B Obj
If set to Yes, this option varies the shape of the object — randomly picking a shape 
that lies between the A & B objects. (Of course, A & B must be different for this to 
have any effect.
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Randomize Color is slider controls how much the color is randomized.


Randomize Angle: is slider controls how much a new object’s orientation is 
randomized.
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AutoBots
AutoBots are self contained algorithmic forms. ey are similar to DrawBots in that 
they use the A:B objects as their draw shapes, but unlike DrawBots they draw 
themselves in their entirety from a single mouse click. Select an AutoBot, and click the 
mouse in the scene to create an AutoBot. AutoBots are also morphable, and can be 
animated from one AutoBot to the next to create movies or image sequences. Also, 
AutoBots can be edited in real-time, by adjusting their parameter sliders. 


It’s important to understand that objects created by an AutoBot are dynamic and their 
objects are not individually editable or selectable (unless you optionally detach the 
geometry from the AutoBot – see below). In this first section below, we’ll discuss 
creating and editing non-animating AutoBots in the scene. In the second section, we’ll 
discuss morphing (creating animation) with AutoBots.


Creating Scene AutoBots (Non-Morphing)
One or more, non-morphing, AutoBots can exist in your scene along with any 
DrawBot or static geometry. 


Adding an AutoBot to your Scene
Select the Bot from the Bot Options panel, and click once in the scene. GroBoto 
determines your Bots location by “looking” at the spot you clicked on. If you touch the 
surface of another object, it will use that point. Otherwise, GroBoto scans the vicinity 
of your mouse click position for any other geometry, determining a good average 
screen depth location. at depth (along with your mouse position), is the starting 3D 
point of your AutoBot. Once the AutoBot is drawn, you can then translate or rotate 
the Bot (meaning all of its geometry) as desired (see the section below on selection 
and editing of AutoBots).


AutoBot Instancing Vs. Multiple Seeds
Each time you click to create an AutoBot in the scene, a copy is created with a unique 
name. For example if you select the Fan-Auto Bot and click on two points in the scene, 
you will get two instances: Fan Auto and Fan-Auto-001. You’ll see them listed in the 
[Scene Bot] section of the Library window as well as the Bot selection drop-down in 
the Bot Options panel. Each of these instances is a completely independent copy of the 
AutoBot — editing one has no effect on the other.


Optionally, you can create multiple “seeds” of a single AutoBot instance. After a Bot 
has been drawn once, hold down the (PC:Alt/Mac:Option) key when clicking to create 
a second (or third, or fourth, etc) seed of the Bot. In this case, the AutoBot won’t be 
copied. Rather a “clone” of the Bot will appear. is clone, or seed, does not have its 
own unique set of parameters. Each seed belongs to the same AutoBot instance. So 
when you adjust a Bot parameter, you will see all of the seeds change. 


AutoBot Real-time Editing
Once placed in your scene, AutoBots can be edited in real-time. As you drag any 
AutoBot slider, the Bot will continuously redraw in polygon mode. When you release 
the mouse, the Bot redraws in the current render mode.


AutoBot Real-time A:B Object Editing
In addition to sliders, you can also adjust the Bot’s A:B objects and see those changes 
in real-time. For example, after creating an AutoBot in the scene, go to the Bot 
Objects & Texture panel and rotate either the A or B object (select the Rotate icon and 
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click and drag the mouse in the A:B Edit View). As the object rotates in the A:B Edit 
View, you’ll see the AutoBot update in the main display. Similarly, try reshaping the 
A:B objects. 


Saving Customized AutoBots as Presets
Click the Save… button in the Bot panel to save an AutoBot and all its parameter, 
texture, and A:B object settings as a preset. You must save your Bot to your GroBoto/
Bots folder (or any folder inside that Bots folder) for it to be available from the Bot 
drop-down menu. is will be the default directory when you click the Save button. 


Updating the Bot Miniature Prior to Saving 
Before saving an AutoBot preset, you can update its miniature. is picture is shown 
at the top of the Bot Options panel, in any drop-down menu of Bots, and in the 
Library Panel.  Right-click on the picture at the top of the Bot Options panel, and 
select Update Miniature From Scene. is changes the graphic to a snapshot of the 
current rendered display. When you save the AutoBot, this miniature will be saved 
with the file.


For best results adjust the camera and lights as desired to get a good picture. Ideally, 
you should redraw the Bot in an empty scene to avoid confusing the image with 
unrelated objects.


AutoBot Selection and Editing
When selecting an AutoBot, you will select all of the geometry created by the Bot 
regardless of the selection tool options (i.e. even if the select option is Single or by 
Type, you always select the entire Bot). Further, you can only translate or rotate the 
entire selection. AutoBot objects are dynamic and tied to their Bot; the objects are not 
individually selectable or editable. 


Detaching AutoBot Geometry
As noted above individual objects of an AutoBot cannot be edited. However, you can 
detach the objects of an AutoBot from its Bot making them static objects in the scene 
(and therefore editable). Like so:


• Select the AutoBot in the scene with the Select Tool. Simply click on any part of 
the Bot in the scene.


• Select  Edit >Detach AutoBot Objects from the main Menu. You’ll get a dialog 
box to choose your grouping option. It’s a good idea to put your objects in a new, 
named group for ease of selecting and editing later. is Detach AutoBot 
Objects menu item also appears in the context menu when right-clicking on an 
AutoBot object in the scene.


Deleting An AutoBot & Its Geometry
To delete an AutoBot and its geometry (meaning it no longer appears in the [Scene 
Bots] section of any Bot selection menu or the library), go to the library window and 
right-click on a Bot instance name, then select Delete. Warning: if your Bot has not 
been saved, it will be lost.


Deleting An AutoBot’s Geometry Only
To delete an AutoBot’s geometry without deleting the Bot instance, first select the 
Bot’s geometry with the Select Tool and then select Edit >Delete Selected Object(s). 
Alternatively, you can select and then press the Delete key.
Mirroring
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Mirroring adds complexity and symmetry to AutoBots. When mirrored, an AutoBot 
generates sets of symmetric objects. e Mirroring setting in the Bot Options panel 
specifies which World space axes (X, Y, Z or combination) are mirrored. Mirroring 
across one axis doubles the number of objects, two axes quadruple and three axes 
increase the number of objects by a factor of eight. Displaying the World Axes (check 
Show World Axes in the Edit panel), will help you understand how the objects are 
mirrored. 


Lock Mirror
Mirrored objects are created around the point clicked on to create the AutoBot. is 
point becomes locked, and it’s not editable for a given AutoBot unless you are creating 
multiple seeds (see AutoBot Instancing Vs. Multiple Seeds above). 


When creating multiple seeds, you can reset the mirror point.  If you uncheck the 
Lock Mirror checkbox in the Edit panel prior to creating the new seed, the mirror 
point is reset. Note: there is only one mirror point for each Bot instance, so all seeds 
of the AutoBot will redraw around this new mirror point.


Ducts & AutoBots
Most AutoBots can be drawn using Ducts (see the section on Duct Conversion under 
DrawBots).  


If the AutoBot is “live” (i.e. its geometry hasn’t been detached — see above), you 
enable Duct generation by checking the Enable Ducts checkbox in the Bot Options 
panel and. is converts the AutoBot into a sequence of Ducts and joining objects. If 
you uncheck this option, the AutoBot goes back to using the A:B objects. 


Note: When adjusting Bot parameter sliders with Ducts enabled, the real-time display 
(i.e., the poly mode shown while dragging sliders) will not show the Duct objects – 
instead it will show the A:B objects. On mouse-up from a slider, Groboto will redraw 
the AutoBot using Ducts. is option is needed because showing Ducts during real-
time parameter editing can be slow.


You can opt to display the ducts in real-time by un-checking the Disable Bot Ducts for 
Preview & Editing checkbox in the Scene Options panel. Depending on the speed of 
your computer & complexity of the Bot, it may be just fine. 
 
If the AutoBot geometry is detached (see Detaching AutoBot Geometry above), then 
individual branches can be converted to Ducts just like DrawBot branches. See the 
section on Duct Conversion under DrawBots.


Non-Ductable Situations
e Enable Ducts control will be disabled, and ducts unavailable, in two cases:


• e AutoBot does not support Duct generation.
• e AutoBot is part of a morph sequence where one or more keyframe AutoBots 


do not support Duct generation. So even if the AutoBot would otherwise 
support Ducts, in this case the control will be disabled.


AutoBots & Texture and Color Assignment
Like DrawBots, you assign texture and color for AutoBot created objects from the Bot 
Objects & Texture panel. But unlike DrawBot objects or objects added from the 
library, texture and color can not be changed for individual AutoBot-created objects in 
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the scene. See the section above on detaching AutoBot objects in order to make them 
individually editable.


When you change the texture assignment in the Bot Objects & Texture panel, 
GroBoto re-renders the scene with the new texture. is is unlike DrawBots where a 
texture change only affects subsequently drawn objects.
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Built-In AutoBots
e range of possible forms for a single AutoBot is gigantic — virtually infinite. e 
beauty of AutoBots is that they are real-time. e best way to discover what they are 
capable of is to experiment. In that spirit, here are some tips & notes for each built-in 
AutoBot.


We have included a basic preset for each AutoBot type (for example: Coral-Basic, 
Lattice-Basic, etc.) ese are less interesting presets of each type (often with several 
settings set to 0). ey are designed to help you understand the structure & function 
of that Bot type. It’s helpful to open one of these “Basic” presets and try adjusting the 
settings one at a time.


ere are several PreSets for each AutoBot family. Try starting with one of these 
presets, and changing one setting at a time.


Often very small changes can make big differences. If moving a slider causes big jumps 
in the overall form, try using the slider scaling to allow for smaller changes.


We are posting detailed descriptions and/or tutorials for each AutoBot family on our 
web site, www.groBoto.com. Please check the site for updates, new Bots, and info.


AutoBot Families included with GroBoto 2.0:
RadialTwoTurn
Coral
Fan
Fern
Fibbo
Lattice
OrbNado
PinWheel
Plant
Rig
SpiroTwoTurn
TriSpiro
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Bot Options Panel Details
e Bot Options Panel is divided into three sections:


• Bot Global Settings - general settings common to most Bots
• Bot Objects & Texture - e two A:B objects (or primitives), 


used by the Bot to construct its form
• Bot Controls - Unique settings for each Bot.


For AutoBots, adjusting any of these sliders will update the Bot 
in real-time. For DrawBots, make your adjustments first, then 
draw.


Bot Global Settings 
e settings in this part of the Bot Options panel are common to all 
Bots (with the exception of BuildBots, see the BuildBot  section).


Speed - Only relevant for DrawBots, limits the drawing speed for 
greater control.


Object Count - Number of objects generated by the Bot. For 
DrawBots, it’s the maximum number that can be created during 
each mouse-down. For AutoBots, it’s the total number of objects 
generated. Note: is number will be increased by a factor of two, 
four or eight if Mirroring is on — see Mirroring below. 


No Limit - is checkbox only applies to DrawBots. If checked it 
means the Bot will continue to draw as long as mouse is held down. 
Note: specific Bots may stop the drawing process on their own — 
like Fan Simple, which draws a fixed number of objects, or any 
tapering Bot that determines additional objects would be too small.


Bot Scale - Controls the overall size of form the Bot creates.


Object Scale - Controls the relative size of the individual objects 
created by the Bot to the overall form that it creates.


A:B Object Amp - Amplifies the difference between the A & B object 
(see Bot Objects & Texture below).


A:B Object Skew - Changes the bias for the A to B object changes. 
Many Bots gradually transition between the A & B objects. Skewing 


essentially moves the mid-point of that transition, so that the changes either start 
quickly and taper off slowly or start slowly and taper rapidly. 


Object Step Skew - Changes the bias of Step Size transitions. Many Bots vary the 
spacing between objects (step size) as they grow. Skewing essentially moves the mid-
point of that transition, so that the changes either start quickly and taper off slowly or 
start slowly and taper rapidly.


Mirroring - Sets mirroring for the Bot. Bots can have any combination of 3 mirrors (X, 
Y, Z). e effect is compounded, so one mirror yields two copies of the Bot form, two 
mirrors result in four copies, and all three mirrors give you eight copies. Please refer 
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to the discussion on mirroring in the DrawBots  and AutoBots 
sections above.
Bot A:B Objects & Texture 
is section is where you define the objects the Bot uses when 
constructing its form. e type of object(s), their dimensions, colors 
& texture are all set here. In addition, there’s an option to convert the 
Bot form to “Ducts” — interconnected pipe or ribbon-like 
structures. 


Setting the A:B Objects
ere are two object views, one large and one small. ey are 3D 
views of the A & B objects. We’ll call the large one the “Edit View” . 
You can only make changes to the object in this larger view. Toggle 
the A & B objects into this view with the A/B button (nested between 
the two views).


Selecting a shape from the pop-up just above the Edit View loads that 
shape. is becomes the A or B object (whichever is currently 
occupying the EditView). Note: for many Bots this will also update 
the other object, as some Bots requires that both A and B objects be 


of the same type – both cylinders for example, ‘tho their proportions may 
differ. 


A:B Object Types
Some Bots require that the A & B objects be the same type, both cylinders 
for example. ose Bots transition from the A object to the B object accord-
ing to their internal rules. So if object A is a short disk-like cylinder, and Ob-
ject B a long narrow cylinder. the Bot might contain all of the cylinder varia-
tions in-between (fig. 5)


Other Bots allow A & B to be different types, say, a cylinder and a ring. In 
those cases, there is no transitioning between A & B. e 
two objects are simply designated to play a certain “role” in 
the Bot’s construction — like rings for “hubs” and cylin-
ders for “spokes” (fig. 6).


Editing the A:B Objects 
Below the edit display box there are several controls. e 
first two from left to right change the camera and zoom of 
the 3D views. Note: both views share the same camera. 
e next two rotate and reshape the object. Each of these 
tools can be used by clicking and dragging the mouse in 
the Edit View box or clicking and dragging on the tool icon 
itself. 


When the reshape tool is active, the drop down menu below the box 
shows the available edit parameters for the selected object (e.g., width, 
length, etc.). To edit an object parameter, either click and drag the 
mouse in the edit display box, or click and drag in the reshape tool icon.


Fixed Rotation - is checkbox overrides the Bot’s rotation of its objects. When on, all 
objects are kept at their orientation as defined in the Bot Panel.
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Figure 6


Figure 5







Bot Objects & Texture continued


Assigning a Texture
Select a texture with the Texture pop-up, (just below the Object B 
Scale slider). All Bots are allowed only one texture. If you have an 
AutoBot in the scene, it automatically redraws, reflecting the new 
texture. If you are working with a DrawBot, all future drawing will 
use the selected texture. e Clear button just below the Texture 
pop-up clears the objects of any texture.


Tinting the Texture
When the Tint Texture checkbox is checked, the object’s color (as set 
by the gradient or solid color below), tints the texture. 


Setting Object Colors or Gradients
Bot object colors are set either from a gradient (from the gradient 
pop-up menu), or from two solid colors (one for object A, and one 
for object B — set in the box below the gradient). If a gradient is 
used, the Bot assigns colors from that gradient to its objects based on 
the transition from object A to B — as the object changes fro a A to 
B, its color changes from left to right in the gradient. Actually, the 
way Bots sample is a bit more interesting — see the Gradient Editor 
reference. 


All of this gradient stuff is only in effect with objects that interpolate 
the A:B objects. Bots that allow two different shape types, and don’t 
interpolate, simply use the solid colors assigned to object A & B.


Duct Controls
For AutoBots only. e Duct Period slider, Enable Ducts checkbox, 
and Round/Flat radio buttons enable Ducts, set the Duct type, and 
number of draw objects per Duct. See the section on AutoBots for 
how to use these controls.
WARNING: By default Ducts are disabled during real-time Bot 
editing & Animation previews (see Scene Panel reference). If you 
changer that default in the Scene Panel, enabling Ducts will make 
real-time Bot drawing very slow.


Bot Controls
Sliders for adjusting Bot-specific parameters. ey are the parameters associated with 
a core Bot type. For example, Rig-Draw has different parameters from say Fan Simple, 
while all Rig-Draw presets have the same set of parameters. Of course, different Rig-
Draw presets might have their parameters set to different values.


Please refer to the tooltips for each slider for specific parameter information (i.e., how 
it affects the Bot behavior).  


For AutoBots, adjusting any of these sliders will update the Bot in real-time.
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Animation • Morphing with AutoBots


GroBoto has only one type of animation — Kinetic Morphing. It’s much simpler 
than a full keyframing system, but much more than a morph sequencer. With 
GroBoto’s Kinetic Morph System you can:


• Morph a series of AutoBots
• Animate the location of the AutoBot while it morphs
• Animate the Camera, Lights, Fog & background colors
• Animate location or direction of Lights


A morph sequence is created by adding AutoBots to the Animation Strip located in 
the Animate panel. GroBoto morphs from one AutoBot in the strip to the next using a 
kinetic system controlled from the Morph Settings panel. We will refer to the 
Animation Strip cells as keyframes. Each keyframe contains an AutoBot and also 
stores the state of the camera, light, fog and background color settings for that point 
in time. 


It’s important to keep in mind that there is only one morphing AutoBot — one 
AutoBot form that’s changing over time. e scene may contain other non-morphing 
AutoBots, DrawBot geometry, or other static geometry.
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Setting Up a Morph
Here are the basic steps:


1. Add two or more AutoBots to the Animate panel animation strip. You 
can drag & drop them from the Library or — after you have one in the 
Animation Strip — clone it using (Shift+Drag PC, Option+Drag MAC). 
Optionally for PC users– click the Add Bot button at the bottom of the 
Animate Panel. 


Each AutoBot in the strip becomes a keyframe in the animation.


2. Click on a keyframe to select it. e keyframe’s AutoBot becomes the 
selected Bot in the Bot Options panel and the AutoBot appears in the 
scene. 


3. Edit the Bot’s parameters in the Bot Panel and/or make changes to its 
location or orientation in space with the Edit Tools.


4. Edit a keyframe’s camera, light or fog settings & background color set-
tings as desired.


5. In the Morph Settings panel, make changes to the morph settings for 
the current pair of morphing Bots (by pair we mean the currently selected 
keyframe and the AutoBot in the next keyframe).


Repeat steps 2-5 as desired for other keyframes.


6. Click the Preview Animation button the Animate panel (Esc key can-
cels the preview if desired).


7. Select File->Render Animation… and render the animation.


In the following sections we’ll describe these steps & options in detail.


Adding AutoBots to the Animate Panel Animation Strip
From library panel, drag an AutoBot from either the Standard Bots >Auto section or 
any saved AutoBot from the User Bots section, and drop it on the Animate Panel’s 
Animation Strip. (DrawBots can’t be animated, and GroBoto will not let you add them 
to the Animation Strip)


Optionally for PC users– click Add Bot from the bottom of the Animate Panel.


Note: Each keyframe in the Animation strip contains a unique instance of an AutoBot, 
these AutoBot’s are listed in the [Scene Bots] section of the library window (and in all 
pop-up menus that show Bots). 
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Cloning Keyframes within the Animation Strip
Hold down the (Shift key PC, Option key MAC) and drag the keyframe cell to the left 
or right in the animation strip. Release the mouse within the strip where you want to 
place the new (cloned) keyframe. If you drop on an existing cell, the cloned keyframe 
is placed in front of that cell. e cloned keyframe contains a copy of the AutoBot, 
camera, light, fog and background color settings from the original. Note: the cloned 
AutoBot will be given a unique name, and it will appear in the [Scene Bots] section of 
the Library. 


Moving Keyframes
Click and drag the keyframe of interest in the Animation Strip and drop it at a new 
location. If you drop while your mouse cursor is on an existing keyframe, your 
dropped keyframe will be positioned before the dropped-on keyframe. (On the PC, If 
you drop with the mouse cursor is in-between two keyframes, it will be positioned in-
between).
e strip scrolls automatically if needed.


Selecting a Keyframe & Editing a Keyframe’s AutoBot
When you click on a keyframe in the animation strip, it’s selected and the following 
happens: 


Groboto loads the keyframe’s AutoBot into the Bot Options panel for editing.
e scene is redrawn with the Bot, camera, fog, background & light settings from 
the keyframe.


You may then adjust the parameters of the Bot, edit camera, fog, lights, background 
color, and change the animation parameters in the Morph Settings panel.


Important Note: While any edits to Bot Settings or Morph Panel settings are saved 
automatically, changes to camera fog, background color & lights will only be saved 
automatically if  the Active checkbox in the Animate Panel is checked. Otherwise you 
must manually save those settings by clicking the Update Key button.


Deleting a Keyframe
When deleting a keyframe, you are also deleting the AutoBot it contains. You can 
delete a keyframe in two ways:


• Right-click on the animation strip keyframe cell. Select Delete Morph Bot.
• Right-click on the keyframe AutoBot from the Library’s [Scene Bots] section. 


Select Delete.


When deleting the last keyframe, all of the geometry created by the associated 
AutoBot will also be deleted. 


Clearing All Keyframes
To clear all keyframes from the Animate panel animation strip, click the Clear All 
button in the Animate panel. All of the geometry created by the keyframe AutoBots 
will also be deleted. 


Editing Morph Pair Settings
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Use the Morph Settings panel to adjust how the animation morphs from keyframe to 
keyframe – the motion and kinetic parameters. See the Morph Settings Panel section 
below.
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Morph Settings Panel
e Morph Settings panel controls morphing from one keyframe to the next (we call 
those two keyframes a “Morph Pair”). Reveal this panel with the Morph Settings item 
in from main menu > Window.


e panel displays one Morph Pair at a time — morphing from keyframe 2 to 
keyframe 3 for example). e number of pairs is always one less than the number of 
keyframes. For example, if you have 3 keyframes, you’ll have two pairs (settings for 
keyframes 1 to 2, and 2 to 3).


Figure 1 shows the panel. Note that the 
lower half shows different controls 
depending on the Object Movement type 
selected.


Morph Pair
e two miniatures displayed at the top of 
the panel show the current Morph Pair. 
You can scroll through pairs, revealing the 
settings for each pair in the various 
controls below. 


When you select a keyframe from the 
Animate panel these miniatures  — and 
the entire Morph Panel — updates. e 
selected keyframe will be on the left. 


Morph Pair Time 
e duration of the morph for this pair of 
keyframes.
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Figure 1


groBoTip
Kinetic Morphing is one of the most 
rewarding features of GroBoto — 
but it can be a little daunting at first. 
We suggest you look at the simple 
Morph Sequence sample files before 
attempting to understand all of the 
details and options.


Using those sample files, try just 
changing one or two settings at a 
time, previewing, and changing again.


Also see the Kinetic Morph Tips at 
the end of this Animation Section, and 
the Simple Morph tutorial on our 
website.







Morph Type
Object Location - is a simple positional morph — each 
object in one keyframe gradually migrates to the 
location (and orientation), of its corresponding object 
in the next keyframe.


Bot Settings - does not directly alter the position or 
orientation of individual objects. Rather it interpolates 
the Bot Settings of the two Bots. Let’s say keyframe 1 
has a Bot with a “curl” setting of 0 (a straight branch), 
and in keyframe 2 the curl is set to 10 (a curled branch 
that forms a circle). GroBoto will gradually increase 
that curl setting over time. e result is very different 
than what you get with the Object Location option 
where the objects simply migrate to their new positions 
(see fig 2).


Object Sequence
Object sequencing distributes the motion of the 
morphing AutoBot’s objects over time.


Get wonderful motion by combining Object 
Sequencing with Kinetic Object Movement — but it’s 
easiest to understand with simple Ease In/Out motion 
& Location Morphing. 


Take a Bot that creates a single branch, and a morph 
that curls the branch into a circle. With Object 
Sequencing, you can opt to have the objects move in 
sequence (based on the order the Bot creates them).  


Figure 3 shows the effect of the Head First/Tail First 
slider on that branch. In this case the  “Head” is at the 


bottom, thicker end of the branch. With a neutral setting (0), the branch curls nor-
mally (just as it would if you manually edited the Bot’s curl setting). With a Head First 
setting (-100), the branch starts curling at the base, remaining  straight towards the tip 
(which only becomes curled at the very end of the morph).


e Object Sequence pop-up has options for skewing the timing of the sequencing. 
ese options can be used to amplify the effects of the Head/Tail First slider. Building 
on the example above, let’s say we combine “Stretch End” from this pop-up with the 
Head First slider setting. e branch would start curling very rapidly at the base, and 
the tip would very slowly and gradually settle into its curled position at the end of the 
morph.


Object Movement
As the AutoBot’s objects move, the rate and character of that motion in determined by 
the Object Movement type (and the settings that go with that type). You can use 
simple smooth Ease In & Out, or the more interesting Laggy & Springy types. ese 
are kinetic simulations — the Bot structure as a whole behaves like a mechanical or 
organic system. It flexes, flows, expands, contracts, while effected by tension, friction, 
elasticity, etc.
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Figure 3


Neutral (0)                Head First (-100)


Figure 2


Obj Location  vs.  Bot Settings







Ease In & Out
Simple smooth, interpolated motion with no kinetic effects. e motion is dampened 
at the start (ease in), and end (ease out). at is, the rate of motion gradually 
accelerates — reaches a steady pace — then gradually decelerates.


Laggy & Springy Movement Types
ese are the two kinetic options. e are based on a common model — each object in 
the AutoBot is linked to its “parent object” (e.g. the previous object in its branch), by an 
invisible force.  Each object in this chain tends to trail behind its parent as the Bot 
moves.


Laggy
Objects are strung together with a weak, spongy, force. When the lagging objects 
catch up, they tend to settle into place with little or no rebound. If the force is very 
weak — and the Stretch setting high (see below), the lagging objects may never make 
it back to their original location — almost like they are linked together with thin 
strands of chewing gum... it tries to pull them along, but fails to contract back to its 
original length.


Springy
Objects are strung together with an elastic force — like a spring. It may be strong or 
weak. If strong, the objects will not separate much, and there will be lots of 
reverberation as they rebound. If very weak, the behavior becomes similar to laggy — 
lots of stretch, and less rebound.


Attraction
e magnitude of force that binds branches or other strings of objects together (See 
Laggy or Springy just above). Higher values tend to keep objects tightly bound 
together with little flexing or stretching.


Morph Duration
e portion of the Morph Pair’s time during which energy is applied. Let’s say we have 
a Bot Settings Morph Type and a Morph Pair Time of 10 seconds. With a Morph 
Duration setting of 50 (meaning 50% of the total time), GroBoto will complete all Bot 
parameter changes during the first 5 seconds. e remaining time it’s “coasting”. e 
objects continue moving after 5 seconds because there is still energy in the system. 


With Springy & Laggy movement you usually want this value to be less than 100, 
because the objects need time to settle after we stop applying energy.


With Ease In/Out motion, you usually want 100% — otherwise the objects will reach 
their end state before the Morph Pair Time is up and be motionless for a while.


First Objects Attraction & Last Objects Attraction
ese are multipliers for the main Attraction slider above. You can increase or 
decrease the amount of attraction based on the order in which the Bot creates its 
objects. For example objects nearer the end might have a much weaker force causing 
them to trail even farther behind in a Laggy morph.
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Laggy & Springy Specific Settings
ese are grouped together here (not in the order they appear in the Morph Settings 
Panel because they are closely related, and are specific to these two kinetic motion types.


Lag (available with Laggy Movement only)
Resistance of the individual objects to movement (something like inertia). Higher 
values cause objects to lag farther behind. Lag works against Attraction (above). If the 
Attraction setting is high, you’ll need more Lag to resist that force.


Governor (available with Laggy Movement only)
Limits the Lag effect — forcing the Bot’s objects to reach their keyframe states. By its 
nature, the Laggy method is “lazy”. Objects end up trailing so far behind that they 
never coalesce back to their original form... but that slow, fluid motion is nice. So 
rather than give it up, you can use the Governor to pull everything back together. 
Higher values force the Bot to tighten up as it reaches the end of the Morph Pairs 
time. Use carefully — very high values can make the motion look, well, forced.


Friction  (available with Springy Movement only)
Drag on the individual objects to movement. With 0 friction, your Bots “springs” will 
oscillate endlessly, never losing their energy. Higher values cause the objects to settle 
quickly with fewer oscillations. Friction interacts with both Attraction (see above) and 
Stretch (see below). If your Attraction setting is high, your virtual springs will be tight 
and oscillate rapidly — low Attraction yields looser, wavy motion. 


Stretch  (available with Springy Movement only) 
Stretch controls how much separation is allowed between objects. It’s like the 
difference between one of those springs that pulls a screen door shut (Stretch = 0), 
and a slinky (Stretch = 100). e door-spring’s length won’t change much if you wave 
it around, while the slinky will stretch greatly. Keeping Stretch low is vital with low 
Friction &/or low Attraction settings — otherwise your Bot’s branches may whip 
around uncontrollably.


Tempo
Expands (values less than 100) or contracts (greater than 100) the Kinetic motion in 
time. For example if a Springy animation is oscillating too rapidly, a low value will 
slow it down.


Object Alignment
To Branch Path aligns each object according to the direction of movement — like the 
links of a flowing chain. is is usually the preferred mode for Laggy & Springy 
morphs of  organic “branchy” forms — it looks natural.


Bot Defined allows the Bot to control the orientation — ignoring any kinetic motion. 
is is used when you want to maintain the structure of the original Bot. When the 
beauty of the Bot lies in its structure — and especially when it’s composed of larger 
objects that may not be oriented end-to-end along a path — you may prefer this 
option.


Stiff Root
Protects objects near the root of Bot branches from kinetic effects. Like a rigid rod 
with a spring on the end, as opposed to one long spring. Actually, it’s more like a stiff 
rod that becomes flexible — there is a transition at some point along its length.
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Common (Non-Interpolating) AutoBot Parameters
ere are several AutoBot parameters that are automatically kept the same across all 
keyframes. ese parameters do not interpolate, and are automatically kept in sync for 
all AutoBots in the animation. All keyframe AutoBots will be automatically updated 
whenever you change any of these settings:


• A:B Object type (cylinder, sphere, etc) set in the Bot Objects & Texture panel
• Texture and tint settings
• Duct Period and Duct Enabled settings
• Object Count


Note: after changing any of these parameters there may be a delay as GroBoto updates the 
keyframe miniatures in the animation strip to reflect the change.  


Morph-at-your-own-risk AutoBot Parameters
Some specific AutoBots have parameters that not recommended for morphing. ey 
are marked with an asterisk(*) by their slider names. Changing them from keyframe to 
keyframe may produce visual discontinuity (jerkiness), in the animation. You may or 
may not want these effects — with kinetic movement types, these sudden twitches can 
actually produce great motion. e kinetic systems tend to dampen the effect, so the 
final results may be sudden — but not discontinuous — motion.


Keyframing the Camera, Lights, Fog & Background Color
As mentioned above, morphing is the focus of our animation system — all other 
animation revolves around the AutoBot morph sequence. However, GroBoto offers 
simple smooth interpolation of the camera, lights and fog/background settings from 
one morph keyframe to the next. Here’s how you animate camera, lights, and fog/
background settings:


• Select a keyframe from the Animate panel’s animation strip.
• Change anything about the lights, camera, fog or background color.
• If the Active checkbox at the bottom of the Animate panel is checked, the 


keyframe will automatically update after any change(s) in step 2. Otherwise, you 
must click the Update Key button to update the keyframe.


ere are no further settings for the interpolation of Cameras, Lights & Fog. ey are 
all tied to the AutoBot Morph Keyframes (they don’t have keyframes or “tracks” of 
their own). Simple smooth interpolation is used in all cases — it is unaffected by any 
of the settings in the Morph Settings Panel.


Active Keyframe Mode
If the Active checkbox at the bottom of the Animate panel is checked, any changes to 
the camera, lights, fog or background color are automatically stored in the selected 
keyframe (see Keyframing the Camera, Lights, Fog & Background Color above).


Note: when the Active mode is on, GroBoto’s status bar turns orange — this reminds you 
that any changes you make are being automatically recorded.


Update Key Button
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Clicking the Update Key button at the bottom of the Animate panel updates the 
selected keyframe with the current camera, lights and fog/background settings (see 
Keyframing the Camera, Lights, Fog & Background Color above).


Note: Changes to the Bot Settings & Morph Settings are always automatically recorded. 
You do not need to hit the Update Key button, or have the Active mode on .


Copying and Pasting Animation Settings


Each keyframe cell in the Animation Strip has 
a context menu (fig. 5; right-click — or 
control-click on Mac’s with a 1-button 
mouse). Use any of the “Copy” items in this 
menu to grab the settings associated with that 


keyframe, and place them on the clipboard.


Right-click on another keyframe to paste. e 
various “Paste” items are enabled/disabled 
depending on which items are present on the 
clipboard & available for pasting.


Copying & Pasting Camera Light & Fog Settings 
With Camera, Light & Fog Settings, they are always copied all at once — later 
choosing which to paste with the various paste options.


Copying & Pasting Bot Settings
You can only copy a keyframe’s AutoBot parameters from one keyframe to another if 
both share the same Bot Type — that is, AutoBots with the same parameter sets. For 
example, you can copy & paste from a keyframe containing a Fern type AutoBot to 
another keyframe containing a Fern AutoBot (or any preset derived from Fern). You 
can’t copy settings from any version of Fern to any version of, say, PinWheel.


Copying & Pasting Morph Settings 
Any morph settings (see Editing Morph Pair Settings above) can be copied from one 
keyframe to another. Note however, that the Bot Settings Morph Type is only valid 
between AutoBots of the same type (see Copying & Pasting Bot Settings above). If you 
paste Morph Setting with the Bot Settings Morph Type, it will switch to the Object 
Location Morph Type in the destination keyframe if required.
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Previewing a Morph Animation
Clicking the Preview Animation button at the bottom of the Animate panel starts the 
preview. e Status Bar and the Animation Strip update to help you track the 
progress. e frame rate of the preview is limited to the current Frames per Second 
setting (see Rendering a Morph Animation just below). GroBoto attempts to preview 
at that speed, however it will not skip frames, so the actual rate may be slower. During 
the preview, press the Esc key to terminate the preview.


Rendering a Morph Animation
You can output a morph animation as an AVI (PC), QuickTime (Mac), or sequence of 
image files.


From the main menu, select File>Render to Movie… to open the 
output window.


In the Image Settings tab, set your image output size and crop 
settings. If crop is enabled, we highly recommend that you preview 
with the crop rectangle displayed before rendering your movie. e 
Magnify tool can change the cropping rectangle relative to your 
workspace, and you may not realize it. See the Magnify Tool and 
Output Panel reference for details


In the Movie tab, select the Movie Format and adjust the total time if 
necessary. Warning: Changing the total time of the animation 
sequence may change the behavior of the morphing keyframes — 
always preview the animation after time changes. 


Click Save Movie to start the movie rendering. During rendering, all 
controls and menus are disabled (you can still close or minimize the 
window and palettes if needed) e Status Bar and the Animation 
Strip update to help you track the progress. e Esc key will 
terminate the Animation (any frames rendered up to that point will 
be saved.)
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groBoTip
The Cropping Rectangle is 
key in creating image & 
movie files. While its use is 
optional, we think that 
more often than not, you’ll 
find it useful. It is essential 
for many movie formats 
that require exact pixel 
dimensions. Many common 
output sizes are included 
in the Preset Sizes pop-up 
menu.







Light and Shadow


Light and Shadow
Responsive feedback makes GroBoto less work and more 
play, an environment where experimentation and exploration 
is encouraged. You can see the results of your lighting edits — 
including full-quality cast shadows — in seconds (or less, 
some light editing is real-time).


GroBoto supports three types of lighting: Local, Distant and 
Ambient. e total number of lights allowed is 16 (not 
counting Ambient). But be aware, Distant lights are 
performance hungry and  memory hungry — they create 
shadows, and usually one or two will do. Local lights do not 
cast shadows and require less processing and memory, they 
are useful for local glow effects or filling in shadows. Ambient 
lighting adjusts the intensity and color of all surfaces in your 


scene. GroBoto’s proprietary ambient lighting does more than simple 
flat-fill lighting. It is quasi-directional and simulates the scattering of 
light from other objects. 


Distant Lights
Distant Lights are directional and they cast shadows. Direction, color, 
intensity and distance can be animated in Kinetic Morphs. As 
mentioned above, Distant Lights require more memory and time to 
calculate, so its best to use only a few — often one or two is enough. 
Combine them with Local Lights to create a rich lighting 
environment. 


Add & edit Distant Lights with the Lighting Options Panel (fig. 1). 
Dragging the Distant Light icon into the scene creates a new light. 


Select lights with the pop-up at the top of the Light Settings area. 


Click the Show Widget checkbox — displaying the light’s control 
widget, a green arrow (fig. 2), that represents the light direction — then 
use the Rotate tool to adjust the direction of the light. 


Disable lights by un-checking on the On checkbox. 
Delete the currently selected Light with the Delete 
button next to the Light pop-up. 


Set Color and Distance of lights with the controls 
located below the Lights pop-up. When adding 
additional lights, consider dropping down the 
Intensity a bit so your scene doesn’t become 
overexposed. e value of a light’s color affects the 
lights intensity. For example, a light set to middle 
gray with an intensity setting of 100 is the same as 
a light that has a full white color with an intensity 
setting of 50.
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Figure 1


Figure 2


v3 Note:
The ability to lock light positions to 
the Camera has been added.  This is 
ideal for modeling.


You’ll find the Light-Lock in the 
Light Panel, and in the Scene 
Context Menu.


Click Here to See the Video 
Or go to:
www.groboto.com/v3docs



http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs





Local Lights
Local lights radiate their light from a single point, like a light bulb. 
ese lights do not cast shadows. ey’re a nice complement to distant 
lights, perfect for filling in shadows and dark areas. Create dramatic 
effects by changing light color and falloff. 


A Local Light’s location is controlled by its “Widget” (fig. 4, a small 
yellow sphere displayed in the interface when you check the Show 
Widget button). Select and move it just like any other object. Right 
clicking on the Widget pops up a context menu with some options for 
that light.


Set light color and intensity by using the Color Swatch and Intensity 
field in the Light Settings area of the Light Options panel (fig. 3). 
Adjust the light’s falloff by checking the Falloff checkbox. Set Falloff 
Distance by either entering a value in the Distance field or by “Drop-
Setting” the distance by dragging the Drop Set Distance icon into the 
scene and dropping it onto any geometry (GroBoto sets the falloff 
distance equal to the distance from the light to the drop spot).
 
e Falloff Profile (see fig. 3), further refines falloff. Increasing the Tail 
percentage causes the light to fade very gradually and increase the 
reach of its illumination. It is best to keep this value low. Higher values 
may produce only subtle differences far from your light, and will slow 
performance — especially when you move the light with real-time full 
rendering. However, it can be useful to increase this setting to faintly 
illuminate distant objects. 


e Slope setting adjusts the steepness of the light falloff  curve. A 
higher setting will result in “hotter” illumination (intensity near the 
source will be much higher than the intensity you set, and fall off 
rapidly). A lower setting yields less of a hot spot and more gentle falloff.  


Some Slope setting variations can be seen in fig. 5.
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Figure 5a: Slope 100, Tail 0                   Figure 5b: Slope 50, Tail 0                    Figure 5c: Slope 50, Tail 70


Figure 4


Figure 3







Ambient Light
Ambient lighting in GroBoto is useful for filling shadows and 
generally brighting your scene. GroBoto’s ambient lighting system 
takes into account object geometry to provide ambient lighting that is 
somewhat volumetric rather than a simple “flat-fill” shading.


Set ambient by clicking on the Ambient Light Color Swatch box in the Light Options 
panel (near the bottom of the Lights Panel). Brighter values will increase the intensity 


of the ambient light.


Shadows
Shadows are cast from Distant lights. ey render very 
quickly, even in Full Quality render mode. is makes 
lighting setup in GroBoto very interactive. Lights can be 
animated in Kinetic Morphs causing shadows to move and 
change during the sequence.


Enable shadows with the Shadows On checkbox in the 
Scene Options Panel (this is a global setting, turning 
shadows on or off for all Distant Lights in the scene). Note 
that shadows will only be visible when working and 
rendering in Shaded and Shaded-Outline render modes, 
the first two modes in the Scene Options panel. 


In order to efficiently render a scene, GroBoto calculates 
shadow coverage in an invisible “Shadow Sphere.” Enabling 
Auto Coverage in the Scene Options panel will 
automatically adjust the Shadow Sphere to cover all objects 
in your scene under most circumstances. ere are two 
Auto Coverage options:


1. Best Quality for View. is emphasizes shadow quality 
over coverage — best when most objects are in the 
middle distance (nothing very close to the camera). 


2. Best Coverage for View. is emphasizes coverage — 
ensuring that all visible objects cast & receive 
shadows. is enlarges the Shadow Sphere, so some 
quality may be lost. is option is often required for 
scenes with dramatic perspective and/or objects close 
to the camera. 


See “Spotting & Correcting Shadow Problems” on the next page for tips on how to 
best manage your shadows and adjust these coverage settings.
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Spotting & Correcting Shadow problems
Managing Shadows is one of the few areas in GroBoto that is 
a bit technical & touchy. It’s a balancing act between best 
quality & efficient memory usage. e potential memory 
requirements are so large, that we must always try to 
optimize. We try to automate that optimization for you, but 
sometimes, GroBoto needs your help.


Fortunately there are reliable ways of spotting and fixing the 
two types of problems that you might encounter: 


• Insufficient Density (shadow dropouts, fig 1). 
• Incomplete Coverage (shadows cut off fig 2).


A basic understanding of  what we are trying to achieve will 
help. Shadows exist in an invisible “Shadow Sphere”. ere is 
a limited amount of data, or resolution, in that sphere. As we 
increase its size, the shadow resolution gets coarser. We can 
crank up the resolution, but there are practical limits as to 
how far. So, our goal is to keep the Shadow Sphere as small as 
possible and only increase resolution (Quality) as much as 
needed.


e first step is to try the two Auto Coverage Options and see 
which works best. Best Quality for View works best when 
most objects are in the middle distance (nothing very close to 
the camera). Best Coverage for View works best when you 
have dramatic perspective &/or objects very close to the 
camera.


If you see cutoffs like those in fig. 2, try the Best Coverage for 
View option. If you still see cutoffs, this means you need to 
expand coverage beyond what GroBoto thought you needed. 
Use the Radius % slider to increase the covered area. Only 


increase as needed — too much and you’ll probably see dropouts like those in fig. 
1. 


If you see dropouts like those in fig. 1, decreasing the radius (if you are using either 
auto mode the radius can only be changed with the Radius % slider). Decreasing 
the radius increases the quality by making the covered area smaller — same 
amount of shadow data in a smaller area. If you decrease the radius too much you 
will see cutoffs like those in fig. 2. Once you have a good fit with the Radius you 
may still need to increase the Quality setting. Always adjust the Radius first. It’s 
usually eliminates most dropouts, and high Quality settings use lots of memory.


e good news — you’ll usually have plenty of wiggle room — you don’t need to 
find ideal settings, and often the Auto modes will do. Depending on your 
Workspace size, a computer with 1-2 Gigs of memory should rarely run into 
trouble. ere is little or no performance penalty for increasing the Quality slider 
unless you run out of memory and the systems starts “spooling” (substituting hard 


disk space for memory). e total amount of memory needed depends on the number 
of shadow casting lights, (2 lights need twice as much shadow memory as one).
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Figure 2


Figure 1


groBoTechNote
It’s possible that you 


may still see shadow 


problems even after 
making these ad-


justments. If you still 
see problems, please 


read the Shadows 


TechNote







Camera
It’s all about your point of view


Camera Widget 
GroBoto has a single, full featured camera. You can zoom, pan, 
orbit, pivot, roll, and change perspective all with one “widget”. 
ere is only one camera, but there’s a handy way of stashing 
and retrieving views, as well as a number of handy default 
views.


In GroBoto, all composition and editing is done through this 
single Camera. e current Workspace is the camera view. 


e Camera Widget in GroBoto allows for a number of useful 
ways to move about in 3D space, all contained in a convenient 


tool that takes up a small amount of valuable screen-estate. While it might 
look like a little complex at first, it’s easy to use and quite powerful.


Note that the icon of the Camera (fig. 1, X ) represents your position relative 
to the controls. is is key to reading the Camera Widget. ink of the 
rightmost wall (fig. 1, Blue Wall) as the screen.


Let’s explore the camera, beginning from where the camera is placed when 
creating a fresh scene.


The Camera’s Home Position
By default, the camera points at the center of GroBoto’s 3D space, perched 


slightly above and to the right (fig. 3). At any time, the 
camera can be sent to this default view, called the 
“Camera Home” by choosing Send Camera Home from 
the Views menu. Send Camera and Geometry Home 
sends the camera home, but also moves all of the 


geometry in the scene to the center of the GroBoto world. 
is is handy if you get completely lost or accidentally 
move your geometry off-screen.


e Preset Views submenu (fig. 2) located in the the 
Views menu has convenient camera positions: front, back, 
left, right, top, and bottom, relative to the center 


GroBoto’s space. Towards the end of this section, we’ll talk about ways to store your 
own views.
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Figure 3.


Figure 1.
You are here
Screen is this wall


Figure 2.


v3 Note:
A new ‘Level’ Camera mode that is 
especially suited to modeling has 
been added in Version 3, along with 
other Camera enhancements.


Click Here to See the Video 
Or go to:
www.groboto.com/v3docs



http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs





Moving the Camera Around 
All Camera adjustments are made by either dragging directly on the widget, or by 
dragging in the Workspace with a modifier key (Command Mac, Control Windows). 
Normally the object editing tools are in effect in the workspace but holding down the 
modifier key temporarily activates the currently selected camera tool instead.


Adjusting the Camera in the Workspace is both a convenience (you don’t have to go 
down to the Camera Widget), and offers ways to link the Camera movement to the 
geometry. More on this below.


Orbit
Orbit the camera by clicking and dragging on the sphere in the center of the 
camera widget (fig. 4,  Orbit/Pivot). e camera’s view will orbit the center of 
the scene’s geometry. When Orbiting in the Workspace, use the modifier key 
combo, (Command-Option Mac, Control-Alt Windows), to orbit around the 
touched surface (the object surface under the cursor, rather than the center of 
all geometry). is is a very useful composing feature. You can keep focus on 
whatever part of the scene you like (even if it’s not in the center), and avoid 
the Orbit-Pan-Orbit-Pan sequences that are often required otherwise.


Pivot
Pivot is similar to orbit, but the Camera remains stationary, while pointing in 
a different direction. As if you were holding it and “looking around”. Clicking 
the Pivot checkbox (fig. 4,  Orbit/Pivot Toggle) on the left side of the widget 
enables Pivot.  is option is vital when you are in tight  — immersed or 
surrounded by geometry.


Roll
Often after orbiting the camera, the scene will appear askew. Use the Roll 


icon (fig. 4,  Roll) to quickly roll the camera and level the scene. 
On the next page, we’ll show you how to “truck” the camera, that is, move it sideways, 
up and down, and back and forth, which is also called “translation.”
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groBoTip
To quickly orbit the 
camera while working 
in the workspace, hold 
down the Command 
key on Mac or Control 
key on PC to orbit the 
camera. The camera 
will orbit around the 
geometry below the 
cursor.  To pivot the 
camera around geome-
try, hold down 
Command-Option on 
Mac or Control-ALT 
on PC. 


Orbit/Pivot Ball


Roll


Orbit/Pivot Toggle


Figure 4.







Planes of Translation
GroBoto allows camera movement, or “translation,” along three planes. ese are 
represented by the “walls” (see fig. 5) surrounding the center sphere in the Camera 
Widget. Clicking and dragging in a plane moves the camera within that imaginary 
plane. For example, clicking on the bottom plane moves the camera Left/Right and 
Forward/Back. e left plane moves the camera Up/Down and Forward/Backward, 
while the right plane moves it Left/Right and Up/Down.
  
Restrained Translation
Sometimes it is convenient to restrain camera movement to one direction, like vertical 
only. e Restrained Translation sections (see fig. 5) of the widget make this possible. 
e Vertical Translation Strip restrains movement of the camera to up and down. e 
Depth Translation Strip to depth, and the Horizontal Translation Strip restricts to 
horizontal movement.


Perspective 
Drag the Perspective Adjustment (see fig. 7) down to increase the perspective, up to 
decrease. Increased perspective exaggerates geometry angles (fig. 6) and shows more 
of your scene. It’s like using a wide angle lens. It’s a dramatic effect and more 
perspective gives a sense of greater scale. On the other hand, lower perspective will 
provide a flatter, less distorted view of the scene.


Field of View
e field of view is similar to a zoom lens on a camera. Drag down to zoom in, up to 
zoom out. 
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Truck X (Left/Right)


Truck XY 
(Left/Right, Up/Down)


Truck XZ
(Left/Right, In/Out)


Truck YZ
(Up/Down/, In/Out)


Truck Z (In/Out)


Truck Y (Up/Down)


Figure 5.


Perspective


FOV (Field of View)


Figure 7.Figure 6.







Magnify - (Not really a Camera Tool)
e Magnify Tool is located just below the Workspace (fig. 8). It changes your view (in 
the same way as the Field of View tool — prev. page), but it’s intended as a 2D tool — 
not a Camera Tool — more like zooming in & out in a 2D paint program. We can’t 
talk about the Magnify Tool without talking about the Crop Rectangle. e Crop 


Rectangle controls the exact size & shape 
of your image when you save a picture or 
animation to disk. It’s controlled in the 
Output dialog box (fig. 9).


e difference between the Magnify & 
FOV tools is best observed by trying each 
with the Crop Rectangle displayed.


Use the Magnify Tool (fig. 8) to 
temporarily enlarge or reduce your view of 


the scene. e Magnify tool (magnifying glass icon), and Field 
of View tool (protractor-like icon at bottom of Camera 
Widget) do the same thing (zoom you in and out) - With one 
important difference: 


e Zoom Tool also zooms the crop rectangle. is allows 
you to zoom in — perhaps to do some detail work — without 
changing the content of your cropped area, or to zoom out to 
reveal the entire cropping frame, again, without changing the 
contents of the cropped area. 


Field of View does just the opposite... Leaves the size of the 
crop rectangle in the Workspace unchanged, while filling it 
with more or less of your scene. e three screen shots in fig. 
10 shows the difference: 


At the top (A), we see the original view with its cropping 
rectangle. 


In the middle (B), the result of  zooming out with the Magnify 
Tool. Note that the content of the cropping rectangle is 
unchanged. If we rendered this scene to file, we would get 
exactly the same image as if we had not zoomed out.


In the bottom view (C) we see the result of zooming out 
(from A), with the FOV Camera Tool. Note that this time our 
crop rectangle stayed the same, but its contents are very 
different. If we rendered this scene, we would get this more 
distant view.


e important thing is, when cropping is enabled, you will 
always get exactly what you see inside the crop frame. If you 
are using the Cropping Rectangle, you should always display 
the crop when previewing animation and before rendering 
anything to file.
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A


B


C


Figure 8.


Figure 9.


Figure 10.







The View Stack - Storing Custom Views
When working on projects, great camera angles will be discovered. 
GroBoto allows camera positions to be saved for later retrieval in the 
View Stack. Each view is represented by a thumbnail of the scene and 
an, (optionally), assigned name.  Views in the View Stack are saved 
with your scene file.


Save custom camera positions to the View Stack by (optionally), 
typing a title for the camera view in the field located to the right of the 
Save button (see fig. 11). Click the Save button to store it to the View 
Stack. 


Delete views from the View Stack by:
MAC - Hold down the Command Key while 
selecting a view in the View Stack Menu (you will 
see the text next to each miniature change to 
include the word “Delete” as soon as you press 
the key. 
WIN - Hold down the Control Key while 
selecting a view in the View Stack Menu.


Choose Clear View Stack from the Views menu 
to remove all views from the stack. Note that 
there is no undo!
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Figure 11.


Figure 12.







Textures
GroBoto Textures
Our proprietary texture system frees you from mapping 
projections and the distortions that often come with them. It 
creates seamless, pattern-less, tiled textures from any bitmap. 
is technology is well suited to, and in the spirit of, GroBoto. 
Fast, easy, and beautiful. 


at being said, it does have some shortcomings. You can’t put a 
label on a soup can, or map your face to an ellipsoid — yet. Our 
technology will mature to offer broader options, but right now 
they offer beautiful surfaces for all of your objects.


How are GroBoto Textures Made? 
GroBoto’s textures are made up of three components:


• Tiling Schemes
• Color Maps
• Bump Maps


Tiling Schemes
e tiling scheme is an arrangement of tiles scattered on the objects surface. ey 
are derived from a bitmap mask. ey may look like torn paper laid in random 
directions, or scattered puzzle pieces. A scheme is defined by its mask, and its 
“Tiling Properties” (essentially the relative size of the tiles to the object).
 
Color Maps
Color Maps are RGB or Grayscale TIFF images. e Library contains a few to get 
you started. Add new maps by placing any TIFF file in your Maps folder (located in 
the /GroBoto/Maps directory). No need to restart GroBoto, these folders are 
monitored. Your color maps will appear in the Library as well as relevant pop-up 
menus.


Bump Maps
Bump Maps add small surface features to your texture. Use any RGB or 
Grayscale TIFF. Color will be read as gray. Strength & direction of the 
Bump effect is edited in the Textures Panel. Place TIFF images in your 
GroBoto/Maps folder if you want them to appear in the Library and pop-
up menus.


Mixing these three texture components together creates a 
vast variety of Textures. 


Tinting
One more thing effects the appearance of a texture, Tint 
(it’s not a property of a texture, but rather, of an object). 
Each object has a “base color”. You may choose to have 
that color tint the texture of any object. is way, many 
objects that share a texture can vary in hue. (more details 
on tinting below). 
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Tile Map...


+ Color Map...


+ Bump Map







Adding Textures to Objects
ere are several ways to add or change an objects texture:


• Drag a Texture from the Library onto any object. 
• Drag & Drop from the Textures Panel.
• Use the Apply This Texture button in the Textures Panel — handy for applying a 


texture to a group of selected objects.
• Select a Texture from the pop-up in the Selections & Groups Panel — also handy 


for applying a texture to a group of selected objects.


Creating new Textures
e Texture Options Panel has a New button (to the right of the 
texture preview sphere). Clicking on the New button opens the New 
Texture dialog (fig. 1), with three options: 


• New Tiled and Mapped Texture.
• Build New Texture From Map.
• New Simple Texture.


e preferred way to create a new texture is the New Tiled & Mapped 
Texture option. It creates a blank slate where you can use any 
combination of Tiling, Color, and Bump maps. e other two options 
are covered at the end of this section. When you give the texture a 
name in the field at the bottom of the dialog, and click the Create 
button, a texture with default tiling is created and displayed in the 
texture preview sphere.


Assigning (or swapping) Tiling Schemes & Maps
Select Tiling Schemes and Maps from the Assign Color Map pop-up 
menus (fig. 2). 


You can freely swap all three components. Note that different Tiling 
schemes can greatly alter the feel of a texture. Obviously smaller tiles 
result in smaller texture features. Note however, even when the scale 
is similar, the different arrangements & overlaps created by each 
tiling scheme can dramatically alter the larger forms & patterns 
produced.


e preset Tiling Schemes found in the Assign:Tiling pop-up are 
really just Textures (with a simple grayscale gradient color map to 
help reveal their structure). You can actually apply the Tiling Scheme 
from any existing GroBoto texture (that’s why you also see regular 
Textures in this menu). 


Likewise, Color & Bump Maps are interchangeable (that’s why you 
see the Bump folders in the Color menu and Color folders in the 
Bump menu). Color will be read as gray when used for bump, 
grayscale will be read as full color when used as a Color Map.


Note: Editing a texture that exists in the scene will update that 
texture on all objects it’s applied to.


T
ex


tu
r


es


70


Figure 2


Figure 1







Texture Options — Tiling and Period
GroBoto includes many tiling presets, which we offer for two reasons:


1. You can get very different appearances by swapping tiling maps (even if 
the color map is unchanged) on any given texture.


2. Tiling Schemes take a while to generate. It’s fast & easy to select a 
preset, making it easy to try many variations. 


ere will be times when you want to edit a Tiling Scheme. Most 
likely to create denser, smaller tiles. Tiling Properties...  in the Op-
tions pop-up menu (fig. 3) brings up the Texture Tiling dialog.


e Tiles value controls the number of tiles used in the map, which is 
somewhat analogous to the overall map scale. It increases 
the  average number of tiles that wrap around the circum-
ference of each object. 


Period adjusts the number of extra tiles created for variation 
of the texture from object to object. is compensates for 
patterning that might be seen when using the same tiling 
arrangement across several objects. e default value (usu-
ally 2 to 3) rarely needs to be changed. When texturing long 
objects (like a long thin cylinder), increasing Period will 
eliminate any repeating.


After you set these values and hit the OK button, you will see 
a progress bar in the “Status” area at the bottom of Gro-
Boto’s main window. It usually takes just a few seconds to 
generate a new Tiling Scheme, but very high Tiling values 


can take a minute or more.


Note: Editing a texture that exists in the scene will update that texture on all objects 
it’s applied to. 


Important Note: Large Tile and/or Period values create large texture data sets in 
memory and in your saved files... only use as needed.


Note: e last item in the Options menu builds a texture using a 4-Channel TIFF file 
on disk (brings up a standard Open dialog). See Building a Custom Tiling Texture 
below for more info.
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Figure 3


Figure 4







Bump Settings
Below the Options popup is the Bump slider (fig. 5a). Sliding to the 
right increases the amplitude of the Bump. e Plus/Minus button 
inverts the Bump (makes bumps into dents and vice versa). 


Specular Highlights
e Specular Highlight sliders (fig 5b), adjust highlight brightness 
and width. A small width and bright setting creates a shiny effect 
and a large width and less brightness yields a duller “matte” look. 


Applying and Removing Textures (for Objects)
Drag textures from the Texture Panel or click on the Apply This 
Texture button (fig. 5c) to apply to one or more selected objects. 
Click the Remove Texture button to remove a texture from one or 
more selected objects. You may also drag textures directly from the 
Library onto objects in the Workspace, or change the texture of 
selected objects by selecting with the pop-up in the Selections & 
Groups Panel (fig. 8).


Applying and Removing Textures (for Bots)
Bot Textures are set exclusively in the Bot Panel. You may either 
select a texture from the Texture pop-up, or drag textures from the 
Library onto the Bot Object Editor. (fig. 6). Click the Clear button 
in the Bot Panel to remove a Bot’s texture.


Tinting Textures (for Objects)
As mentioned above, Textures may optionally be tinted by the base 
color of an object (the base color is the color of the objects surface 
when no Texture is applied). All objects have a property called 
“Tintable”.  fig. 7 shows a single texture with 5 different tints.


An object’s Tintable property and base color are set in the 
Selections & Groups Panel (Not the Textures 
Panel — remember these are properties of the 
object, not the texture). 


Tinting Textures (for Bots) 
Bot object’s base color and “tintability” are set by 
the Bot (not on an individual object basis). 
Commonly, AutoBots and DrawBots create a 
gradient of base colors resulting in gradient 
tinting of its individual objects. With Bots, you 
assign textures, set color gradients, and enable 
tinting all in the Bot Panel (fig. 6).
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Figure 7


Figure 5         (Texture Panel)


Figure 6           (Bot Panel)


Drop 
Texture 


here


Figure 8 (Selection & Groups Panel)







Saving Textures 
Save textures using the Save button located to the right of the texture 
preview sphere. It brings up a standard Save Dialog.
Important Note: We highly recommend you save your textures in the 
GroBoto/Textures folder. Textures saved there are automatically added 
to your Library and pop-up menus. Create as many sub-folders inside 
of the GroBoto/Textures folder as you like.


Important Notes About Maps
Map Sizes
Maps require big chunks of RAM (for speed and quality reasons). Because they are 
tiled, you generally don’t need anything bigger than 256 x 256 pixels. In fact, internally 
the size is controlled by the tiling scheme (color & bump maps are scaled to match the 
size of the tiling mask, and most of our schemes are 256 x 256 pixels.


Your maps don’t have to be powers of 2, or even square — but again, Color and Bump 
maps are scaled to fit the tiling mask. All of the tiling schemes we provide are based 
on square masks. e short story - if you want to try your own color or bump maps, 
256 x 256 pixels is a good bet.


Map File Types & Masks (Alpha Channels)
Because you can swap tiling schemes (which act as masks clipping out a part of your 
image), it’s vital that the entire rectangle of your color & bump maps contain usable 
image. Your color & bump maps should not contain a forth or “alpha” channel (unless 
you are creating a Custom Tiling Texture — see below). A forth channel is harmless as 
log as it’s “un-multiplied”. In Photoshop® this means a true 4th Channel Not Layer 
transparency or a Layer mask.


Valid Map files are any of the following TIFF types:
• 8-Bit (grayscale or color — color is promoted to 24 bit).
• 24-Bit color
• 32-Bit RGB color (with un-multiplied alpha)


Seamless Tiling
e good news is our system does not require that your maps be seamless. e bad 
news is that traditional Seamless Tiled textures will not work in GroBoto’s texture 
system... or at least some won’t. Seamless textures that depend on a regular rectangu-
lar grid arrangement (like a brick wall), will not work. ose designed to yield an or-
ganic pattern (like granite, or a stucco wall), may actually work better.


Creating a Simple Texture
Simple solid color textures are created with the third 
option in the New dialog. New Simple Texture will 
create a flat color texture with no mapping, color, tile, or 
bump. e only reason for creating this texture type is 
having fast, efficient textures with editable specular 
settings. You won’t be able to add color or bump maps 
to these textures later.
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Building a Custom Tiling Texture
You can create a texture using a custom Tiling Mask based on a 
4-channel TIFF file. is is an advanced option. A good 
working knowledge of Photoshop® (or similar image editing 
software), and a basic understanding of 4-channel TIFF files is 
needed.


e only good reason for using this method is if you need a 
custom tiling scheme. If you simply want to add your own 
images as Color Maps, just place them in your GroBoto/Maps 
folder and they will be available as a texture component.


GroBoto creates tiling schemes by randomly “throwing” copies 
of a shape (represented by the alpha channel of an image), until 


the surface is completely covered. Certain shapes are better suited for use as tiling 
masks than others. Simple, compact forms without holes or lots of spidery tendrils 
tend to work best. 


Above is an example of a texture created from a single TIFF file that has a mottled 
green hue (A) and an alpha channel (B) that contains the shape of a leaf.  


To make a tiling mask, create a TIFF file with a your mask shape in the alpha channel. 
For maximum edit-ability in GroBoto this must be an “un-multiplied” TIFF. In 
Photoshop® this means your mask must be a 4th Channel Not Layer transparency or a 
Layer mask.


e mask should be truly a mask, with solid black areas, and solid white areas. It’s ok 
to have some gray areas or gradients around the edges, but your mask won’t work if 
there is not a substantial solid black area. at said, it’s best blur the edges of the mask 
a little (gaussian blur with a radius of 0.5 to 1 pixel). Color information in the RGB 
channels will be used when you create your texture, but or any Color map can be 
assigned later, (as with any GroBoto texture). Your TIFF can be any size, but anything 
over 512 x 512 pixels will eat up a huge chunk of memory. 256 x 256 is what we 
consider “standard”. See “Important Notes About Maps” above for more detail on 
image size.


After creating a TIFF with alpha mask, click on the New button in the Textures & 
Options panel. Select the second option, Build New Texture from Map. Select a TIFF 
by either selecting it from the Maps drop-down (if the TIFF was placed in your 
GroBoto/Maps directory), or choose the Select Map From Disk button to locate the 
TIFF file. 
Tiling and Period values can be set here, or adjusted later in the Options drop-down. 
Name the texture and click the Create button to begin building the texture. Once the 
texture has been created, it can be further customized by swapping in different  color 
or bump maps.  
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Scene
Render Modes, Fog & other global stuff
In this section we look at all of the things that effect your GroBoto scene as a 
whole, sometimes called “Global” properties. ese include settings for:
•Render Modes
•Shadows
•Fog
•Post Render Filters


All of these properties are found in the Scene Options Panel. We will also 
touch on a few other features that are global (or perhaps universal), in nature 


— like how the GroBoto universe is constructed, what are its 
boundaries, where is its center?


Because of GroBoto’s unique ability to use its full 
quality render modes as work modes, the settings you 
make in the settings panel are also used for final output 
to image or movie files. Often they will be the same as 
your working settings. However, for performance 


reasons, you may want to temporarily change these settings. See the 
Responsiveness & Render Modes section for some ideas on optimizing 
your workflow.


Render Modes
ere are four Render Modes. From left to right in the 
Scene Panel they are:
•Shaded
•Shaded with Outline
•Outline
•Quick Line


Shaded & Shaded with Outline are full render modes — 
they are the best, and slowest modes. ey render shaded, 
textured surfaces and, optionally, cast shadows. e only 
difference is; Shaded with Outline adds a colored, anti-
aliased (smooth edged), outline to all object edges 
(including internal object seams and object intersections).


Outline renders just the edges of your objects — like a line 
drawing ere is no shading, texture or cast shadows. Fog 
can be used with this mode. e interior of the objects can 
be set to a single color, or to match each objects base color. 


e background and line colors can be independently set.


Quick Line is a fast single pixel outline (not anti-aliased). Line, object and background 
are all fixed to a set of blues. is is a good work mode when speed is important but 
you still need a faithful diagram of the intricacies of objects and their intersections. 
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(turning off all of these modes by switching Poly Always on — described below — is 
faster still, but offers only a very crude impression of your scene.


Double Z
e Double Z checkbox enables a special mode that eliminates 
certain rendering errors that can occur with lots of similar, 
tightly packed objects. Generally, you should leave it off unless 
you see problems — there are some memory & performance 
costs. Please see the Technical Notes for details. 


Polygon Modes
GroBoto’s geometry — unlike many 3D applications — is not 
constructed of polygons. Instead it is procedural, true, 
mathematically described surfaces. We offer very crude 
polygonal representations of all of object for performance 
purposes only. GroBoto’s default setup switches automatically 
to this mode only as needed (this default setup is shown in fig. 
2). 


Poly Always overrides other render settings and locks GroBoto 
in polygon mode. 


e Poly Camera & Bot and Poly Local check boxes tell 
GroBoto when to use its auto-switching feature. Poly Local is 
rarely needed, and can in fact be slower than allowing GroBoto 
to use full rendering. is is because GroBoto has been 
optimized to move relatively small objects or groups of objects 
in a fully rendered scene (this is what we mean by Local 
rendering). You might find Poly Local useful when moving or 
rotating a large object or group — but we often prefer to 
quickly switch in & out of  Quick Line Mode for those 
operations (much better for seeing exactly where you are 
moving or rotating to — see the groBoTip & fig. 3). 


Always Highlight Selection
When on, this makes GroBoto’s selection highlighting more 
persistent. Normally (with this checkbox off), object highlighting 
temporarily disappears when you start editing the selected object.


Disable Ducts for Previewing & Editing
GroBoto normally disables Ducts anytime it switches to Fast Poly 
mode. at’s because Ducts greatly slow poly mode performance 
when editing AutoBots or previewing AutoBot animation. 
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Figure 2


groBoTip
Use the Workspace con-
text menu to easily 
switch scene settings. 
Many Scene Options (like 
render mode and shad-
ows are also available in a 
Context Menu that pops 
up when you click on any 
blank (background) part 
of the Workspace).


Figure 3







Shadows
All of the settings here are covered in detail in the Light & 
Shadows section. Here, we’ll just cover the basics. 


Cast Shadows are created by Distant lights. e Shadows 
On check box turns cast shadows on & off for all Distant 
Lights.


e Auto Coverage and associated controls below it help to 
optimize shadow quality and performance. Again, please 
refer to the Light & Shadows section for detailed informa-
tion on these settings.


Backdrop & Fog
GroBoto offers simple solid color backgrounds and basic 
fog. Although simple, these settings can greatly enhance 
your scene. Both can be edited interactively in a fully ren-
dered scene making the process very intuitive. 


Fog & Backdrop always share the same color. Edit this color 
interactively by dragging it into the Workspace (on the 
MAC, all of theses Color Boxes are universal draggable 
items. Be sure to drop it on a background area — dropping 
it onto an object will change that objects color.). When you 
drop the color, you enter GroBoto’s Mouse-Up Color Edit-
ing Mode


 You will see this cursor when you are in this Mouse-
Up color editing mode. It’s “trapped” in an invisible box in 
the workspace (represented by the orange bordered box 
above - although only the special cursor will appear on 
your screen).


Moving the cursor within that box changes the brightness 
(vertical position within the box) and saturation 


(horizontal position within the box). Your scroll wheel 
changes the hue (or Up/Down keys). 


e cursor moves in a 2-D Brightness/Saturation 
color space, while you scroll through Hues.
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Figure 4


=Brightness


Saturation
(Scroll Wheel or Up/Down 


Arrow keys for Hue)


Figure 4







Setting & Editing Fog
Toggle Fog on & off with the Fog check box. When you first add 
Fog to a scene, hit the Fit Fog to Scene button. is fits the Fog to 
the visible objects in your scene. is is a good starting point, but 
you can refine your settings with the Fog Control — a separate 
panel you open with the Edit Fog button — it may take a moment 
to open as GroBoto sets up for real-time fog editing.


e main feature of the Fog Panel is the Fog Slider. e good news is that Fog editing 
is completely interactive and real time on your fully rendered scene — you will 
quickly get a feel for this tool by watching its effect.


e Fog Slider allows you to move and scale your “Fog Bank” relative to the visible 
objects in your scene. e Fog Bank is represented by a translucent bar with yellow 
triangles at either end. e depth of your scene is represented by a bar of spheres. 
When the Fog Bank matches the spheres, it indicates Fog that starts at the nearest 
visible object in your scene, and reaches 100% at the farthest visible object, (what you 
get if you hit the Fit to Scene button).


Move the Fog Bank by dragging it by its middle, or stretch it by dragging the handles 
at either end. Moving to the left places more Fog between you and your scene, moving 
to the right pushes the fog farther away.


Because you might want to make fine adjustments, or place either end of the Fog Bank 
far from the ends of you scene, the entire Fog Slider is scaleable. If the Sphere Bar is 
too narrow, or too wide, hit the Zoom to Fit Control button — that will adjust the 
width to a good editable size. You can also manually zoom the control with the +/- 
buttons. All of the zoom operations have no effect on the Fog in your scene — they 
simply scale the control.


e Scene Options panel also contains two Drop & Set Items; Near Point and 
Mid Point. ese offer a quick way to change your Fog settings without opening the 
Fog panel. Dropping the Near Point onto any surface moves the near (or starting) 
point of the Fog Bank to the depth of that drop point. Dropping the Mid point sets the 
middle of the Fog Bank (where Fog reaches 50%) to the depth of the drop point.
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Fog Bank


Scene Depth


Near Far







Post Render Filters
GroBoto offers a few simple filters to enhance your 
rendered image. No doubt we will add more in the 
near future, but our goal here is to compensate for the 
dullness that often occurs with standard rendering. 
ese filters all tend to increase contrast and detail. 
e 4 filters in the Filter pop-up are:


• Glaze
• Glaze Warm
• Glaze Cool
• Bleach


e strength of all filters is set with the Strength 
slider.


All of the Glaze filters tend to make images darker and 
increase contrast. With scenes that are already on the 
dark side — and you want to crank up the filter 
strength — you may want to increase your light 
intensities to compensate for this darkening effect. 
e only difference in the three Glaze filters is color 


balance. Glaze is neutral, whereas Glaze Warm & Glaze subtly shift the color balance.


Bleach is an overexposure effect. It’s most effective on scenes that are bright and have 
light colored backgrounds.  


Note: ere is a small performance loss on some computers with these modes. Most  
noticeable with real-time local rendering (like moving a small object DrawBot 
drawing). You might want to switch these off until final rendering.


An original unfiltered image and the results of two filters are shown below.
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Unfiltered                                         Glaze Warm                                           Bleach







REFERENCE
Here you will find:
Main Interface
• Basic item-by-item descriptions of all 


of GroBoto’s primary interface 
elements.


Other Interface Stuff
• Basic item-by-item descriptions of 


additional GroBoto Panels, Menus, 
Cut, Copy & Paste, etc.


Workflow & Performance
•How GroBoto handles files & folders. 
• Information on managing GroBoto’s 


performance & memory appetites. 


e information in this section is brief — for 
more in-depth discussions and to get an 
understanding of the how’s & why’s of GroBoto 
tools and features, please see the Main Features 
section above.
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REFERENCE Main Interface


Click on a color shaded area above to learn more...


Main Menu - Save, Load, Copy, Paste, and other general purpose stuff.


Library - Access to all of GroBoto’s raw materials: Textures, Maps, Objects, Bots


Workspace - Where the scene is displayed and edited. Many tools work within the 
Workspace, either directly on objects, or through special control “Widgets”.


Edit/Animate Panels - Two sets of tools are located here Edit Tools (shown - 
Camera and Object tools) & Animate Tools ( or Kinetic Morph Animation).


Options/Editor Panels - ere are five tabbed panels here (selected with the 
five icons at the top — Selections & Groups, Scene, Lights, Textures, Bots)


Other Panels & Controls - Gradient Editor, Morph Panel, and a few other 
items not shown in the image above. 
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Reference • Main Interface •


Library
Where you’ll find all of GroBoto’s raw materials:
• Textures
• Maps (Images used with textures)
• Objects (Geometry Primitives & Simple Groups)
• Bots


e Library is a list of all of your GroBoto files — including built-in files, and files in 
your GroBoto folder. e Library is located on the left side of the GroBoto Workspace. 


If you don’t see the Library:
• MAC - Reveal it with the disclosure button on the left edge of the 


screen, or with the Toggle Library item in the Layout menu. 
• WIN - Reveal it by selecting Tool Palettes > Library from the 


Window menu.


Dragging to Panels or Workspace
is example show dragging a Texture from the 
Library to the Texture Options Panel or onto scene 
objects.
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groBoTip
We highly recommend that you 
save all of your GroBoto files in 
the appropriate GroBoto folder 
for easy access.


The Library keeps track of 
these folders and stays in sync. 
Library files are also available in 
the many GroBoto popup 
menus peppered throughout 
the interface.
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Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM


Library Types - Click to jump to de-
sired Library section (Textures, Maps, 
Geometry, Bots)


Library Menu (mac only) - Basic 
Library navigation, plus access to the 
Browser.


Library Items - Drag, Double-Click 
or use the Context Menu to edit or add 
these elements to your scene.


Drag & Drop 
• Textures - to objects in the scene or to 


the Texture Options Panel. 
• Bots - to the Bot Options Panel, or 


Morph Panel. 
• Objects - into the Scene, or the Bot 


Object Editor.


Library Preview - As you roll over 
Items, a larger preview image appears 
here (you cannot drag from here).


Library Search - Type here to 
search Library Items by name.


Finds text anywhere in items name. If 
more than one item is found you can cy-
cle through with these buttons.


Legend:







Reference • Main Interface • Options Panels


Selections & Groups
One of Five Options/Editor Panels:
• Selections & Groups
• Scene Options
• Light Options
• Texture Options
• Bots


e Selections & Groups panel is where you view & set the properties of Objects in 
your Scene and organize and manage Object groups. e Options Panel is 


located on the right side of the GroBoto Workspace. 


If you don’t see the Options Panel:
• MAC - Reveal it with the disclosure button on the right edge of the 


screen, or with the Toggle Options  item in the Layout menu. 
• WIN - Reveal it by selecting Tool Palettes > Main Controls from the 


Window menu.
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groBoTip
Bot generated forms 
and the objects they 
contain behave differ-
ently when it comes 
to things like groups 
and Textures. For ex-
ample, you do not as-
sign Bot textures in 
this panel. See the Bot 
Options Panel for de-
tails.


See the Bots & 
Groups notes below 
for more information.


v3 Note:
Several new controls have been added to this panel. They are shown 
on the following pages. The Mesh Density settings relate to v3’s new 
Mesh output (which is not covered in any detail in this document). 
Here is where you can find more information:


Mesh Output PDF
www.groboto.com/v3docs
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Tabs - Select Option Panel (Selection & 
Groups, Scene, Lights, Textures, Bots)


Selected Objects Texture - 
Texture applied to the selected object(s)


Texture Pop-Up - Change the 
Texture of selected object(s).


Tintable - Whether or not the tex-
ture will be tinted by the base color of 
the selected objects.


Object Color - Base color of 
selected objects (also used to tint 
texture). 


Randomize Color - Randomizes 
base color of selected objects. Repeat for 
more randomization. 


Group - Shows the group that the 
selected objects belong to.
Group Pop-Up - Change the group 
assignment of the selected objects


Group Manager - Create, rename 
or delete Groups.
• Group Pop-Up - Select Existing 


Group for renaming or deletion.
• Group Name - Rename a Group..
• New Group - Create a new, empty 


group.
• Delete Group - Delete selected 


Group. Deleting a group does not 
delete the objects belonging to that 
group.


Drag & Drop Settings - See next 
page.


Duct Conversion - See next page.


continued...


Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM 
usage


Legend:







Duct 
Conversion


Before:


After:
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...continued from previous page


Drag & Drop Settings - Whether 
any drop on an object (ex. color, 
texture), will be applied to that object, 
or all selected objects.


Duct Conversion - Convert a 
selection of objects to a Duct (a 
connected pipe form). Only available for 
objects created by a Bot (with DrawBots 
you do the conversion here, with 
AutoBots it’s a setting in the Bot 
Options Panel).
• Duct Type - Prior to conversion, 


choose either Round or Flat (ribbon-
like) Ducts.


• Duct Sampling - Prior to 
conversion, set the number of source 
objects that will be converted to a 
single duct segment. 


• Convert Current Selection - 
Convert selected objects using the 
settings above. Only available for 
objects created by a DrawBot.







Reference • Main Interface • Options Panels


Scene Options
One of Five Options/Editor Panels:
• Selections & Groups
• Scene Options
• Light Options
• Texture Options
• Bots


e Scene Options panel is where you set the global properties of your Scene & 
Workspace (like Rendering Mode & Shadow settings).  e Options Panel is 


located on the right side of the GroBoto Workspace. 


If you don’t see the Options Panel:
• MAC - Reveal it with the disclosure button on the right edge of the 


screen, or with the Toggle Options item in the Layout menu. 
• WIN - Reveal it by selecting Tool Palettes > Main Controls from the 


Window menu.
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groBoTip
The most used Scene 
Options are also avail-
able in the Workspace 
Context Menu 
(*Right-Click in Work-
space)


*Control-Click on 
Macs with a one-
button mouse.
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Tabs - Select Option Panel (Selection & 
Groups, Scene, Lights, Textures, Bots)


Render Modes - Full Quality, Full 
Quality w/Outline, Outline, Fast Line.


Render Mode Options - Options (if 
any) for the current Render Mode - 
Adjust, then hit the apply button.


Double Z - Eliminates Render prob-
lems caused by tightly packed objects. 


Polygon Always - Forces fast 
polygon mode (usually GroBoto 
switches to polygons only as needed). 
• Polygon Camera and Bot - Best 


adaptive polygon mode -- switches to 
polygons only with global camera 
changes & AutoBot editing. 


• Poly Local - Uses polygon mode for 
local edits like moving individual ob-
jects or drawing with a DrawBot.


Always Highlight Selection - 
A more persistent highlighting of 
selected objects .
Disable Ducts for Preview - 
Ignores ducts in fast poly mode — draws 
normal primitives instead.


Shadows On - Turns Shadows on/
off for all distant lights
• Auto Coverage - Seeks best 


balance of coverage & quality.
• Include Screen / Include 


Viewpoint - Seeks best balance of 
coverage & quality. Include Screen 
emphasizes quality, Include Viewpoint 
emphasizes  coverage.


• Radius / Scale / Quality - ese 
controls allow you to manually set  - 
or adjust the results of the automated 
- Shadow coverage settings.


See the Light & Shadow section for 
more information.


continued next page...


Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM 
usage


Legend:


v3 Note:
All of the ‘Poly’ options 
should be off when 
Custom Booleans are 
present in your Scene. 
For more info, please see:


www.groboto.com/
v3docs



http://www.groboto.com/v3docs
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...continued from previous page


Backdrop & Fog Color - Sets the 
color of the fog and backdrop. Drag and 
drop to adjust dynamically.
• Fog - Turns atmospheric fog effect 


on/off
• Sticky Fog - Keeps fog relative to 


objects as you change camera settings.
• Fit Fog To Scene - Matches the fog 


range to the closest and farthest 
visible objects.


• Edit Fog - Opens the real-time fog 
editing tool. 


• Drop & Set / Near/Mid Point - 
Drop on any surface in the scene to set 
the near distance or mid distance of 
the fog.


Post Filtering - Some simple filters 
to enhance your final image. ere is a 
small performance hit when any of these 
filters are on. 


Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM 
usage


Legend:
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Light Options
One of Five Options/Editor Panels:
• Selections & Groups
• Scene Options
• Light Options
• Texture Options
• Bots


e Light Options panel is where create & edit your Lights.  Note that Light position 
& direction are controlled with ”Widgets” in the workspace. See the main 


Light & Shadow Section for details. e Lights Panel is located on the 
right side of the GroBoto Workspace. 


If you don’t see the Options Panel:
• MAC - Reveal it with the disclosure button on the right edge of the 


screen, or with the Toggle Options item in the Layout menu. 
• WIN - Reveal it by selecting Tool Palettes > Main Controls from the 


Window menu.
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groBoTip
Shadow casting (Dis-
tant Type), require lots 
of processing power & 
RAM. Try using just 
one or two, Distant 
lights in your Scene, 
with Local lights for 
additional lighting ef-
fects like shadow filling 
and highlighting ob-
jects or regions.


v3 Note:
The ability to lock light positions to 
the Camera has been added.  This is 
ideal for modeling.


You’ll find the Light-Lock in the 
Light Panel, and in the Scene 
Context Menu.


Click Here to See the Video 
Or go to:
www.groboto.com/v3docs
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Tabs - Select Option Panel (Selection & 
Groups, Scene, Lights, Textures, Bots)


Drag into Scene - Drag these 
icons into scene to create new Distant 
(directional, shadow casting), or Local 
(omnidirectional, falloff) lights (16 lights 
maximum).


Lights Menu - Select a light. 
• Delete - Delete this Light. 
• ON- Turns the selected light on/off.
• Show Widget -Displays a “Widget” 


in the Workspace for moving local 
lights and rotating distant lights.


Light Color & Multiplier - Set 
the color and intensity of the selected 
light.


Falloff - When on, light loses inten-
sity with distance.
• Distance - Distance at which light 


reaches full intensity (as specified 
above)


• Drop Set Distance - Drop on 
any surface in the scene to set the 
falloff distance (above), equal to the 
distance of the light to that surface.


• Falloff Profile - Controls how 
rapidly the intensity falls off, and how 
long (and gentle) the tail is as it ap-
proaches 0.


• Reveal Widget in View - Auto 
adjust Camera so that the selected 
lights Widget is visible in the Work-
space.


Ambient Light - Adjust color and 
intensity of Ambient light (light from 
many directions).


Note: Settings for a local light shown. 
Distant lights have fewer settings (Color, 
Intensity, Distance).


Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM 
usage


Legend:
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Distant Light Widget - A Distant 
Light’s Widget, controls its direction (a 3D 
green line with a yellow arrow tip). Rotate 
with the Rotate Tool. 


Local Light Widget - A Local Light’s 
Widget, controls its location (a 3D yellow 
sphere). Move with the Move Tool. 


groBoTip
Context Menus provide a 
quick method of selecting 
tools related to Lights, 
turning them on & off, 
and showing/hiding their 
Widgets .


Editing Lights in the Workspace - e Show Widget checkbox (see prev. 
page), reveals and selects a lights Widget. e Widget is manipulated much like any 
other object in your scene. It even reveals its depth by dimming when it goes behind 
other objects. Select Light Widgets with the Select Tool (Edit Panel).
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Texture Options
One of Five Options/Editor Panels:
• Selections & Groups
• Scene Options
• Light Options
• Texture Options
• Bots


Create & edit Textures in the Textures Options panel.  Textures can be dropped onto 
objects in the Workspace from this Panel. 


If you don’t see the Options Panel:
• MAC - Reveal it with the disclosure button on the right edge of the 


screen, or with the Toggle Options  item in the Layout menu. 
• WIN - Reveal it by selecting Tool Palettes > Main Controls from the 


Window menu.


R
ef


er
en


ce
 • 


In
te


r
fa


ce


93


groBoTip
Note that this Panel is 
your texture creation/
editing area — it does 
not necessarily con-
tain the texture of the 
selected Objects 
(when you select an 
object, its texture is 
displayed here as a 
connivence, but this 
editor might also con-
tain a New or just-
loaded Texture that is 
not yet in your scene.


v3 Note:
When editing GroBoto’s new Custom Booleans, it is best to use the default 
texture (or our ‘Simple Textures that have no Color or Bump Maps).  It also 
helps if your objects are grey, or at least not saturated or brightly colored. You 
will get better performance, while making the special highlighting and other 
boolean workspace elements clearer.


Click Here to See the Video 
Or go to:
www.groboto.com/v3docs
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Tabs - Select Option Panel (Selection & 
Groups, Scene, Lights, Textures, Bots)


Texture Name - Name of this 
texture.
Texture Preview - Live rendering 
of texture; any changes you make will 
show here. Your can drag from here to 
objects in the scene, or from the Library 
to here.
New - Brings up New Texture Dialog.
Save - Save (always “Save As...” bring-
ing up the standard file dialog.
Textures Pop-Up-  Load any 
texture from the Library.


Assign: Tiling/Color/Bump - 
Swap any of these three components 
into the current Texture.
Options Pop-Up - Get Color or 
Bump maps that aren’t in the Library 
(load them from any folder).


Bump Slider & +/- Button - Set 
the height of the bump and flip direction 
(make bumps into dents).


Specular Bright - Intensity of the 
specular highlight.
Specular Width - Width of the 
specular highlight.


Selected Objects:
Apply This Texture - to any 
selected objects.
Remove Texture - Remove any 
texture from the selected Objects.


Texture Info - Basic info on this 
texture. 


Delete Unused Textures - 
Deletes any textures that are not applied 
to any objects in the scene.. 


Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM 
usage


Legend:
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New Texture Dialog - Creates a New 
Texture — there are three New Texture 
Types:


• Tiled & Mapped - GroBoto’s standard 
type.


• Built From Map - an 
advanced option — 
see the Textures Sec-
tion


• Simple - No color or 
bump maps — use 
only if you have no 
plans to add color or 
bump.


Texture Tiling Dialog - Tiles sets the 
approximate number of Tiles required to 
wrap around the circumference of an object.
Period sets the size of non-repeating pattern. 


Larger values insure that mul-
tiple objects that share the 
same texture will not contain 
the same tile arrangement. A 
setting of 2-3 is usually 
enough, setting higher than 
needed will eat up RAM.


groBoTip
A fast way to create new Tex-
tures is to start with an exist-
ing Texture or Template (from 
the Textures PopUp), and just 
swap-in different Tiling, Color, 
and Bump. Then just apply to 
your objects, or save to your 
Textures folder — files saved 
there are added to the Tex-
tures Pop-Up Menu automati-
cally.


Dialogs in the Textures Panel - ese dialog boxes are triggered by buttons 
or menu items in the Textures Options Panel.
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Bot Options
One of Five Options/Editor Panels:
• Selections & Groups
• Scene Options
• Light Options
• Texture Options
• Bots


e Bot Options panel is where you edit your Bots. Bots are the most powerful 
creation tools in GroBoto. See the main Bots section for details. e Bots 


Panel is located on the right side of the GroBoto Workspace. 


If you don’t see the Options Panel:
• MAC - Reveal it with the disclosure button on the right edge of the 


screen, or with the Toggle Options item in the Layout menu. 
• WIN - Reveal it by selecting Tool Palettes > Main Controls from the 


Window menu.


R
ef


er
en


ce
 • 


In
te


r
fa


ce


96


groBoTip
Easily open any Bot 
used in your scene 
with the Workspace 
Context Menu (right-
click on any Bot ge-
ometry in the Work-
space). One of the op-
tions in that menu is 
loading the Bot that 
created the object you 
clicked on.
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Tabs - Select Option Panel (Selection & 
Groups, Scene, Lights, Textures, Bots)


Bot Global Settings Box- 
Settings in this area are common to all  
Bots (with some variation).
Save As - Save this Bot with a new 
name.
Reset - Revert all settings to the last 
saved state.
Bot Pop-Up Menu - Select a Bot to 
edit & run. 
Bot Miniature -  Representative 
miniature of Bot (right click to update). 


Speed -  How fast the Bot draws. Only 
reduce to help control DrawBots.
Object Count / No Limit - 
Number of objects Bot will create. No 
Limit is only used with DrawBots - 
meaning until mouse button goes up.
Bot Mirrors -  Select the mirror 
direction. Note, increases objects cre-
ated by 2,4 or 8 times.


Global Bot Settings
• Bot Scale - Overall size of form 


created by Bot.
• Object Scale - Relative size of 


individual objects to the overall form.
• A:B Object Amp -  Set the 


magnitude of the transition from the 
‘A’ to ‘B’ objects (see A:B Objects 
below).


• A:B Object Skew -  Bias the 
transition from the ‘A’ to ‘B’ objects 
(see A:B Objects below). For example 
the change might start fast and end 
slowly.


• Step Size Skew -  Bias the change 
in object spacing. For example the 
change might start fast and end slowly.


continued next page...


Drag & Drop Item


Drag & Set Item


Has Workspace 
Widget


Affects 
Performance


Increases RAM 
usage


Legend:
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...continued from previous page. 


Bot Objects & Texture
1. Shape PopUp - Select a basic shape for 


the Bot.
2. Shape Editor - Make changes to the ‘A’ 


and ‘B’ objects. 
3. A:B Toggle - Swaps the A and B shapes 


into the editor (larger of two views).
4. Shape Editor Options - Tools for 


reseting and matching the A:B shapes.
5. Shape Editor Tools - Tools for reset-


ing and matching the A:B shapes. e 
first two are camera tools (just to get a 
better view), the second two change the 
shape (Rotate, and Reshape).


6. Fixed Rotation - Force objects to  
fixed “upright” orientation - rather than 
being controlled by Bot.


7. Object B Scale - Add an additional 
scaling factor to the ‘B’ object. is is the 
best way to create tapering branches (it’s 
awkward editing two objects of very dif-
ferent sizes here). 


Texture Pop-Up Menu - Select Bot’s 
texture.
Tint Texture - If checked, texture is 
tinted by the gradient or solid color.
Gradient or Solid Color -  Select a 
gradient from the pop-up menu, or a solid 
color.


Ducts -  Convert this Bot to Ducts (see the 
Selection & Groups page for info on these 
settings).


Bot Controls - Each Bot loads its own 
custom controls here. Each control has a tool 
tip.


1


2


3
4


5 6


7
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Edit/Animate Panels
Two Panels share space at the bottom of the workspace:
• Edit - Tools used to Select, Move, Rotate & otherwise edit objects. 


Some aspects of Lights & Bots are also controlled here. 
• Animate - Contains the Animation Strip - Create & manage your 


morph keyfranes for creating GroBoto Kinetic Morph animation.


Dragging to the Animate Panel
Add AutoBots to a Morph Sequence by dragging 
them from the Library to the Animate Panel.


R
ef


er
en


ce
 • 


In
te


r
fa


ce


99


groBoTip
Most of the Edit 
Tools are available in 
the Workspace Con-
text Menu (right-
click on any object 
or Light Widget in 
the Workspace). This 
is especially handy 
when you are work-
ing on a Morph Se-
quence — eliminates 
toggling between 
Edit & Animate Pan-
els.



perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730

perma://BLPageReference/E9975B69-AD14-40A9-A439-A62D34AC0730





Reference • Main Interface •


Edit Panel
R


ef
er


en
ce


 • 
In


te
r


fa
ce


100


e Object Editing Tools share space at the bottom of the Workspace with the Ani-
mation Panel. 


e Camera Widget is also located at the bottom of the Workspace. See the Camera 
Widget Reference or Camera Section for info.


e Camera Widget and Object Edit widgets work in a similar way. Each widget has 
one or more draggable element. Click & drag to activate and adjust that element. For 
example, dragging the X element of the Move tool will move the selected object in 
along the X axis.


Most of the tools in the Edit panel, can be used in either of two ways:
1. Click and drag directly on the control.
2. Select the control, then click & drag on an object in the Workspace.


Each has its advantages.
Editing by dragging directly on the controls means you can make multiple changes to 
a selected object or group without having to move the mouse back-and-forth be-
tween Workspace and Controls. For example, Scale, then Rotate, then Move.


Editing by clicking on objects in the Workspace allows you to make multiple edits 
without having to select objects first. For example you could individually move sev-
eral objects by first selecting the Move Tool, (making it the active tool), then clicking 
and dragging on each object in the Workspace. As long the selection tool is not 
locked, each click will both select the object, and start the editing.


Move Widget - Move 


the selected object(s)


Rotate Widget - Rotate 


the selected object(s)


Reshape Sliders - Re-


shape the selected Ob-
ject(s). Sliders change 
to show each object 
type’s settings.


Tool Options - additional options for 


the selected tool.


Status Bar - Informs you 


of lengthy operations, 
warnings, etc.


Bot Tool - ‘Seed’ 


AutoBots (set their 
starting point), or 
draw with DrawBots.


Toggle - Switch 


between the Edit 
& Animate Panels


Select Tool - Select 


the object(s) to edit
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Edit Panel


ere are a few buttons at the top of the Edit Panel:


Lock Selection 
Lock Selection prevents any of the Edit Tools — except the Selection Tool — from 
changing the selection. is is vital for certain editing operations. For example the 
option to snap to a touched objects center when moving.


Lock Z 
is is about the undefined nature of depth with a 2D image like your GroBoto scene. 
When you move or place an object, the mouse location tells GroBoto where you want 
it to be left/right & up/down (X & Y), but what about depth (Z)? GroBoto handles this 
in  two ways; 


One, by adjusting the depth to match the depth of any surface you touch  — 
which is fine, and highly intuitive... as long as there is a surface to touch. 
Two, when you want to place something in empty space — GroBoto allows you 
to set and lock the depth with Lock Z. 


Pressing the “Z” key at any time locks your depth at the depth of the surface under 
your cursor. Once Z is locked, it sets depth for a variety of operations including:


• Dropping Objects from the Library
• Adding Local Lights
• Starting an AutoBot or DrawBot
• Moving objects withe the Edit/Move tool


e lock is set to a distance from the camera — not a fixed location in 3D space. Its 
relative to your point of view, not to the other objects in the scene. If you subsequently move 
the camera, the Z plane will move relative to those objects.


Lock Mirror
is option is specifically for Bots. When an AutoBot or DrawBot has mirroring on, it 
automatically sets the mirror location when you first draw or seed the Bot. If you 
continue to add to a Mirrored DrawBot, it reads that original mirror point and 
continues to use it. Overall mirroring is pretty automatic with Bots. However, there 
are times when you want to override the automatic behavior. Locking the Mirror 
prevents Bots from automatically changing it. (see the Bots Section for details).
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e Animation Strip shares a panel at the bottom of the Workspace with the Object 
Editing Tools. 


e Camera Widget is  also located at the bottom of the Workspace. See the Camera 
Widget Reference or Camera Section for info.


e Animation Strip is not really a “Keyframer” — no tracks, curves & such. Some 
simple keyframing of Lights, Camera & Fog are possible, however all of those ele-
ments, along with the Bots share the same keyframes. ink of it as a Morph Se-
quencer plus.


Morph Target Cells - Drop 
Bots here (from the Library) 
to create a sequence. Dropped 
Bots are inserted in front of 
any existing Cells.


End Cell Drop - Drop your Bot 
here if you want it inserted at the 
end of the sequence.


Update Key - Manually 
updates Lights, Camera, Fog, 
and Background Color. 
Only needed if the ‘Active’ 
button is not checked.


Active - When checked, any 
changes made to Lights, Camera, 
Fog, or Background Color are 
automatically saved in the cur-
rent keyframe.


NOTES: Bot & Morph settings 
made in the Bot Options and 
Morph Settings Panels are al-
ways saved in the current key-
frame. The Status bar turns or-
ange when you are in this ac-
tive mode to remind you that 
you are editing keys with your 
every move.


Progress Bar - ‘Seed’ 
Tracks the animation 
progress when Pre-
viewing or Recording.


Toggle - Switch 
between the Edit 
& Animate Panels


Status Bar - 
Frame count, 
frame times and 
estimated time 
to finish are 
displayed here.


Delete/Clear All - 
Delete a single Cell — 
or Clear & delete all 
Cells.


Morph Settings - Opens 
the Morph Settings Panel


Preview - Plays the animation 
in the Workspace in fast Poly-
gon mode.
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Workspace
Working in the workspace -
e Workspace is where you both view and edit your scene. It is capable of displaying 
your scene in the same full-quality rendering that you get with final output. In 
addition, several kinds of “Widget” and “Helper” objects may be displayed. 


Many of the most common edits are performed directly in the Workspace by 
Clicking, Dragging or Dragging & Dropping — including:


• Moving, Rotating & Shape-Editing of objects.
• Moving & Rotating Lights.
• Drawing with DrawBots.
• Changing the Camera view.
• Adding Objects by Dragging & Dropping from the Library.
• Changing Textures by Dropping them on Objects.
• Changing Object color.
• Changing Background color.
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World Axes


Selection Axes


Cursor


Distant Light 
Widget


Drop Objects 
into Scene


Drop Textures 
on Objects


groBoTip
Most of the Edit 
Tools are available in 
the Workspace Con-
text Menu (right-click 
on any object or 
Light Widget in the 
Workspace). 
Many Scene Options 
(like render mode 
and shadows are also 
available in another 
Context Menu that 
pops up when you 
click on any blank 
(background) part of 
the Workspace).







Items like Lights, Textures & Primitives can be dropped directly into the Workspace.


Lights have special ”Workspace Widgets” (3D representations), that may be displayed 
in the scene. Widgets can be selected, moved or rotated much like any other object.


Camera Tools and Edit Tools can be used by clicking & dragging their interface 
elements at the bottom of the screen. However, in many cases, additional functionality 
is available when you use them in the Workspace. at is, select them from the panel 
but apply them, (click & drag), in the Workspace.


For example:
• When rotating (either Camera or an Object), you can opt to pivot around the 


“touch point” (the point on any surface you are touching with the mouse).
• When moving, you can opt to snap to the location of touched objects. You can 


align to the orientation of that object, or the orientation of a touched surface.


Options for this kind of interaction with touched surfaces & objects are found in a list 
just below the widgets. See the Edit Panel Reference for details.


Switching between Camera & Edit Tools in the Workspace
At any moment there is an active Camera Tool (Orbit, Pan, Roll, etc.), and an active 
Edit Tool (Bot, Move, Rotate, etc.). When your cursor is in the workspace, the active 
Edit tool is in effect. Holding down a key (Command Key Mac, Control Key Win), 
switches you to the active Camera Tool. e cursor will remind you which tool is in 
effect.
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v3 Note:
A new ‘Level’ Camera mode that is 
especially suited to modeling has 
been added in Version 3, along with 
other Camera enhancements.


Click Here to See the Video 
Or go to:
www.groboto.com/v3docs



http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs





Reference • interface • Other Stuff


Output Panel
Saving image & movie files, or exporting .OBJ files for use in other 3D applications all 
start with the Output Panel. is panel is displayed when you choose Render to File or 
Export from GroBoto’s File menu.


Buttons for showing/hiding and fitting the Cropping Rectangle are also found in this 
pane. e Cropping Rectangle is key in creating image & movie files. While its use is 
optional, we think that more often than not, you’ll find it useful. It is essential for 
many movie formats that require exact pixel dimensions. Many common output sizes 
are included in the Preset Sizes pop-up menu.
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Image/Export Tabs -
The left side of the panel displays settings 
for either image/movie out put or polygon 
export (to the Wavefront .OBJ format.) 


Image/Movie/Geometry Tabs -
The right side of the panel displays file 
format and other settings related to 
specific filetypes.


Cropping Rectangle - 
e cropping rectangle can be resized in the Work-
space by dragging on its sides or corners. If you con-
strain its proportions while resizing (using the Shift 
key), the output pixel size (as displayed in the Output 
Panel) does not change. If you resize without propor-
tional constraints, the pixel sizes will change. Specifi-
cally, GroBoto will maintain the same approximate 
area as the proportions change. is means you can 
refine your crop while maintaining the same file size 
and overall resolution. See the Camera Section for 
more on Cropping
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Output Panel Images &  Movies
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Saving image and movie files starts with the Output Panel. e settings on the left 
side of the Output Panel are shared by both single images and movies. e differ-
ences are seen on the right side. e Cropping Rectangle is key in creating image & 
movie files. While its use is optional, we think that more often than not, you’ll find it 
useful. It is essential for many movie formats that require exact pixel dimensions.


Use & Show crop - Move 
the selected object(s)


Crop fitting -
Automatic fitting 
of the cropped 
view to the Work-
space.


Render & Save Button -
Brings up a standard Save 
dialog box, and renders the 
image to file.


Alpha Options -
4th channel mask 
that is saved with 
images.


Width & Height - 
Output size in pixels


Keep Ratio - maintains image 
proportions if you change one of 
the values.


Preset Sizes - 
Select from 
several com-
mon output 
sizes.


Output filetype -
File format that 
will be saved to 
disk.


Save Movie Button -
Brings up a standard 
Save dialog box, and 
renders the Animation 
to file.


Frames per Second & Total Time -
These work together to set the total number of frames that 
will be rendered. Changes in Total Time will be distributed 
proportionally across all Morph pairs


Movie Format -
Choose either a single movie file (MAC QuickTime; 
WIN Windows Media), or a sequence of numbered 
image files.
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Output Panel Exporting to .OBJ
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While GroBoto itself does not use polygons (except for its fast draft mode), it is nec-
essary to convert GroBoto geometry to polygon meshes if you want to bring it into 
other 3D applications. GroBoto handles great complexity — especially thousands of 
curvilinear objects — pretty easily. 


However, when exporting you will need to be aware of how many polygons you gen-
erate. High-fidelity mesh representations of curved surfaces add up quickly if you 
have thousands of individual objects. Also, many 3D applications bog down if you 
flood them with thousands of individual objects. is Export Panel allows you to 
control both the number of polygons produced (through subdivision settings), and 
the number of individual objects (through grouping)


Adjust All - Proportionally 


increase or decrease the 
subdivisions for all objects


Presets - Select from several 


predefined subdivision sets 
for all objects


Object Grouping - 


Organize the exported objects into 
groups. This can make managing the 
geometry easier when you import it 
into another application.


Export Button - Brings up a standard 


Save dialog box, and saves the OBJ file.


Poly subdivisions - 


Set the level of detail 
for individual GroBoto 
object types.


v3 Note:
GroBoto’s new Unified SeamNet Meshes are not covered in this 
document. They are one of the most important v3 features, and 
are fully covered in Videos, online Documentation, and a special 
PDF. Here are the links:


Mesh Output PDF 


Click Here to See the Video 
www.groboto.com/v3docs



http://www.groboto.com/v3-media/pdf/SeamNetMesh-Notes.pdf

http://www.groboto.com/v3-media/pdf/SeamNetMesh-Notes.pdf

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs
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Bot Gradient Editor
Bots use special Gradient Images creating gradually 
changing colors for their objects.


Any Tiff file can be used a source for Gradients, so feel free 
to create them with any image editing application. 
GroBoto provides a simple editor allowing you to make 
some adjustments (some peculiar to the way GroBoto uses 
the images).


Opening the Gradient Editor Panel
e Main Menu >Window > Gradient Editor item opens 
the panel. ese Gradients are only used by Bots, so the 
Editor is most often used when you have a Bot loaded into 
the Bot Panel — however you may want to open it simply 
for the purpose of creating, editing and saving Gradients.


Two-Dimensional Gradients
You’ll notice some of the included gradients are not simple 
linear gradients like this...


...but actually little pictures like these: 


at’s because our Bots sample from the gradients in two directions, left/
right & up/down. As the Bot gradually samples from left to right, it also 
randomly changes the vertical location of its sample. When the gradient is 
simple (no vertical variation), you get a simple gradient with your Bot 
(because this vertical randomizing makes no difference). When the gradient 
has vertical differences, it creates organic looking variegated, or mottled 
coloration.


It’s fun to just pull any 
old picture into the 
gradient editor and see 
what you get — and we 
have a vertical smear 
tool in the editor that 
will turn any picture 
into a simple linear 
gradient.
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groBoTip
Drop any Tiff file into your 
GroBoto > Gradients 
folder and it will auto-
matically be available in 
both the Gradient Editor 
and the Gradient pop-up 
in the Bot Panel. Size and 
proportions are automati-
cally adjusted by groBot to 
work with our Gradient 
system.
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Bot Gradient Editor
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Source Image - Current loaded 
gradient Image


Get From Bot - Loads the gradient 
from the currently active Bot.


Load New - Load a new image from 
any TIFF file. e image is automatically 
scaled to the gradient dimensions.


Gradient Folder Pop-Up - 
Select from all of the Gradients on disk.


Smearing & Bluring - Select one of 
three image filters.


Adjusted Image - Shows the results 
of the adjustments below.


Horizontal Flip - Flip left/right.


Hot Spot - Brighten or darken a 
narrow section of the Gradient. 
• Location - Move the Hot Spot left & 


right 
• Bright- How much to darken or 


lighten the Hot Spot.
• Width -Set the Hot Spot width.


Hue Saturation Brightness - 
Adjust the overall color.


Reset All Adjustments - Reset 
everything in this Adjust Gradients sec-
tion to defaults.


Update Bot Gradient - Replace the 
Gradient in the Active with this Gradient


Save to Gradients Folder As - 
Save this Gradient to your GroBoto > 
Gradients Folder with the name entered 
below. (No Save Dialog)
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Edit Menu
e Edit Menu contains several essential fea-
tures. Most of them have key equivalents for 
quick access. 


Undo & Redo
Many — ‘tho certainly not all — actions in GroBoto are 
“undoable”. We often warn you with alerts or interface 
text if an action can’t be undone... but that’s not always 
practical (and could be very annoying). 


e Undo system stores up to 5 actions. e Undo item 
in the Edit menu reflects the most recent item added to 
that list (for example, “Undo Create AutoBot”, or “Undo 
Move Object(s)”). e Redo menu item reverses your 
last Undo.


Important Note: Camera changes can not be undone. 
e solution is to make use of the View Stack. You can stash any significant views 
there and retrieve them later. Of course, this as not as flexible as undo, but making a 
habit of using the View Stack will insure that you don’t lose any vital views.


Cut, Copy & Paste
GroBoto uses the Cut, Copy & Paste menu items (in the Main Menu > Edit), 
exclusively for geometry. You can’t copy or paste lights, cameras, or textures. Note 
that there is a separate Copy & Paste system for animation that does allow you to 
Copy & Paste Camera, Fog & light settings, as well as Bot settings & Morph settings 
between keyframes. Please see the Bots Section for details.


We will cover only the standard (geometry) Cut, Copy & Paste here.


Cut & Copy both place a copy of the selected object(s) on the GroBoto clipboard — 
the difference is that Cut also removes those objects from the scene. Any selection of 
Objects can be Cut or Copied — including objects belonging to an AutoBot. Note that 
cutting or copying AutoBot objects only copies the objects not the Bot. When you later 
paste this copy you will have independent objects, no longer associated with the Bot.


If your goal is to detach objects from a Bot — leaving them exactly where they are but 
making them editable — use the Edit > Detach AutoBot Objects menu item (see 
below).


Pasting
When Pasting, you have two options:


1. Paste - places the objects in the center of your scene.
2. Paste in Place - places the objects in the same location they were copied from.


e second option is useful when you want to create special arrangements of objects 
— for example, several identical objects, each with slightly different rotations.
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Pasted objects are automatically selected, and the selection is locked. With the 
selection locked you have the chance to Move, Reshape, or add the object to a named 
group without needing to click on it. If there is more than one object in your paste, 
you will be prompted to place them in a group... this is optional, but often sensible 
given that you likely will want to select & manipulate that same batch of objects later. 
See the Selections & Groups Reference for details.


Detach AutoBot Objects
is Cuts and Pastes any selected objects belonging to an AutoBot (it’s the same as 
doing a Cut, followed by Paste in place — just faster and easier). Use this option when 
you want to manipulate individual objects created by a Bot. Note that the detached 
objects lose all association with the Bot, they cannot be reattached to the Bot, or 
edited by it. 


Clear Scene & Reset Document
ese two items perform similar actions. Both remove all geometry from the scene. 
Reset Document also Resets Lights, Camera, & Fog to their default settings. Clear 
Scene maintains your Camera, Light & Fog settings.


Reset Document is very similar to the File > New menu item except that File > New 
also sets the document name to “Untitled”. 


File > New  is more appropriate when you really want to start over from scratch. 
Otherwise (if you use Reset Document, you might forget and accidentally save over 
your original document).


Select All Geometry & Deselect
ey do what they say, but note that Select All Geometry only selects objects (not 
light widgets), while Deselect All will deselect any & everything, including Light 
Widgets.


Delete Unused Textures
is simply removes from memory any textures that are present in your document but 
not used anywhere in your scene. For example, you may have deleted all of the objects 
that were using a particular texture. is removal is important because Textures use 
quite a bit of memory, and will make your saved file size larger. is is not really a 
problem if you only have a few, but you might build up a bunch of unused Textures 
over time. 
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Figure 2


Figure 1







Workflow & Performance


Fast & Fluid Fun
Balancing high functionality, and 
ultra-high quality output with a fast, 
& fluid workflow is, well, a 
balancing act. 


Ease of use often butts heads with 
depth & flexibility of function. e 
highest quality output and complex 
3D modeling can tax even the most 
powerful computer.
 
In this section we describe how to 


get the best possible creative experience with GroBoto. No matter what sort of system 
you have, you can find options in GroBoto that keep the creative stream bubbling.


GroBoto Folders, Files & the Library
GroBoto automatically monitors its folders, keeping the Library and various pop-up 
menus throughout GroBoto’s interface up to date. 


Important Note:
On both Mac & Windows, GroBoto may not detect deletion of folders. Please do not 
delete the GroBoto folder, or any of its sub-folders while GroBoto is running. is can 
lead to serious problems. Instead, quit GroBoto, delete the folders, and re-launch.


e first time you run GroBoto, it creates a set of folders & sub-folders on you hard 
drive, the top level of these folders is:
 
MAC: Home/Documents/GroBoto
WIN: My Documents/Braid/GroBoto


... it contains six sub-folders: 
• Bots
• Gradients
• Maps
• Primitives
• Scenes
• Textures


We highly recommend that you save all of your GroBoto files in the appropriate 
GroBoto folder for easy access. is means saving to these folders when working in 
GroBoto, and/or moving files to these folders that you’ve created or acquired 
elsewhere.
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Performance & Memory
One of the few things that can truly slow GroBoto down is Hard 
Disk spooling. When your computer runs out of RAM (random 
access memory), it will start using Virtual Memory, substituting 
Hard Disk space for RAM. is is many times slower, and will 
bring any machine to a crawl if it’s constantly in this mode.


Groboto needs a lot of RAM — it uses it to both deliver optimal 
quality, and speed things up by pre-calculating the complicated.


ere are four major components that determine how much RAM 
GroBoto needs.


• Workspace size
• Shadow Casting Lights
• Textures
• Number of objects


In the reference section of this document, we mark the items that 
have the potential for eating up RAM or slowing performance with 
these symbols:


 Increases RAM


 Slows performance


is allows you to avoid or reduce these settings while working, 
(perhaps tolerating a few defects in the working image), if you are 
in a tight memory situation or just want a little faster response.
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Figure 1







Responsiveness & Render Modes
Our overarching goal is presenting the fully realized image as quickly 
as possible. With many GroBoto tools, editing happens in real time on 
the fully rendered scene. With other tools — where this real time 
interaction is not practical — we automatically drop into a fast, crude 
polygon mode and re-render on mouse-up. is combination is often 
very effective, but sometimes — with very complex scenes, or slower 
computers — you may want to take a little more control over your 
work mode render options.


Here are some settings options from fastest to slowest: (All of the 
settings mentioned here are in the Scene Options Panel, fig. 2 and in 
the Workspace Context Menu —fig. 3).


1. Work entirely in Polygon mode
Check Poly Always - is locks GroBoto in polygon (OpenGL®) 
mode. You don’t get a good representation of the final image, but 
you can make a whole series of adjustments without any delays. 
When this item is checked, all other rendering modes are disabled.


2. Use a faster final render mode
e first two Modes in the Scene Options Panel are “Full” 
rendering modes — they include lighting, shadows, textures and 
fog.  ey are also the slowest. You can use these modes as work 
modes, often in real time. However, temporarily changing the 
other, faster modes can dramatically speed your workflow.


Use Quick Line mode - When this mode is selected (and the 
other Scene Options are set to their defaults — Poly Camera & Bot 
checked), it becomes your full-render mode. is means that re-
renders on mouse-up are much faster. Of course you don’t see 
shading, shadows or textures, but the geometry is faithfully 
diagramed and fog well represented.


Use Outline mode - Outline mode is only about twice as fast as 
full rendering, but offers a cleaner render than Quick Line, and can 
optionally reflect objects base colors.


Note: Shaded with Outline is the slowest mode.... Shaded is faster, 
especially with DrawBots, and Workspace Edits of selected Objects.


3. Turn Shadows Off
Un-check the Shadows On box - Shadows take time to calculate — a 
significant part of total render time. Temporarily disabling them (if you 
have one or more than a couple of Distant Lights), might yield the 
performance boost you need. You still get fully textured, shaded objects.
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groBoTip
Use the Workspace con-
text menu to easily 
switch scene settings. 
Many Scene Options (like 
render mode and shad-
ows are also available in a 
Context Menu that pops 
up when you click on any 
blank (background) part 
of the Workspace).


Figure 3


Figure 2







Boolean Modeling Workflow & Performance
Groboto allows you to work in real-time with very high quality rendering. Boolean 
modeling puts an extra load on the system, and uses special display features and 
highlighting. It’s best to keep a ‘lean’ workspace when Modeling with Booleans. Here 
are some tips:


• Use only 1 Distant, Shadow Casting Light (or turn Shadows off). or...
• Use QuickLine Render Mode for more fluid editing. Especially with complex 


Booleans.
• Use only GroBoto’s ‘Simple’ Textures (those without Color or Bump Maps).
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v3 Note:
A new ‘Level’ Camera mode that is 
especially suited to modeling has 
been added in Version 3, along with 
other Camera enhancements.


Click Here to See the Video 
Or go to:
www.groboto.com/v3docs



http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3/Documentation/TVideos/modelVid/

http://www.groboto.com/v3docs

http://www.groboto.com/v3docs





TECHNICAL NOTES


Advanced Methods & Troubleshooting


Shadow Notes
e Light & Shadows Section covers cast shadow coverage and quality adjustments. 
at’s the first place you should look if you are seeing problems. However, there is one 
case where shadow quality problems can not be resolved with those methods — cast 
shadows on a surface that is at a very oblique angle to the camera. is is a shadow-
data density issue — there simply isn’t enough resolution in our internal shadow map 
to properly render the shadows. e Shadow Quality setting has a maximum limit — 
going higher is impractical because of memory required (gets into gigabytes).


GroBoto’s render engine is unique, (and fast), because it does not sub-sample (render 
the image larger and then average it down to output size). We are working to resolve 
this oblique shadow problems without resorting to the “brute force” method of sub-
sampling. However...


e good news is that rendering at higher resolution will always improve (and often 
completely fix), these problems. High resolution is a good fix for still images — 
GroBoto renders big images fast. It’s a bit more trouble with animation — requiring 
rendering large and scaling down later with another application. We plan on 
addressing this issue in a future point release and, at the very least, offering built in 
sub-sampling for animation output.


Double Z Notes
e Double Z option (Scene Panel), fixes rendering errors that may occur as a result of 
the intersection of more than two coincident surfaces. at is, an area in your 
rendering where several nearly identical surfaces are in nearly identical locations. 
GroBoto can have trouble determining which is in front, is can lead to pixelated 
edges, or ragged, misplaced shadows. Turning on Double Z will usually resolve these 
errors. ere is a performance & memory price for this feature (not a big one). You 
might choose to leave it off until you’re ready for final rendering to file.
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Enhanced Features


Improved & Enhanced
is addendum covers extensions and 
enhancements to Bots, Environment, 
Rendering and Textures — not covered in 
the main body of this Document.


Enhanced Features:
• Bot Object Strips
• Sky Gradient
• Stars
• Layered Fog
• Object Self-Illumination
• Texture Self-Illumination
• Interruptible Rendering
• Aligned Texture Tiling
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Bot Object Strips
Multiple primitives for AutoBots & DrawBots


Object Strips Intro
With the Object Strip mode,  Bots use a 
sequence of up to 30 fully editable objects 
with any mixture of types. Several new 
settings control how these Strip Objects 
are used in constructing a Bot form.


Most DrawBots and AutoBots can be use 
this new Object Strip Mode. However, 
Build Bots, and a few version 2.0 Bots 
(those that allow two different object 
types — what we call Alternate-Shape 
Bots), can’t be switched and have this new 
option disabled.


We have created new Strip-capable 
versions those Alternate-Shape Bots, and 
introduced new versions of several other 
2.0 Bots to take better advantage of these 
new options. 


Combined with new object spacing 
options, this new feature tremendously 
expands Bot possibilities. Entirely new 
topologies are formed using objects with 
a variety of lengths, sequencing, and 
spacing.
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Enhanced • Bots • Object Strips
Editing the Object Strip


Adding & Removing Objects
e array of buttons [1], just to the right of the object editor 
pane [2], allow you to:


• Add - append a new object to the end of the strip
• Insert - Insert a new object above the currently 


selected Strip Object
• Remove - delete the currently selected object from the 


strip
• Clear - Remove all objects from the strip — leaving a 


single default sphere.


Dropping & Loading Objects
ere are two ways to bring groups of objects into your 
strip. 


Dropping any Bot onto the editor pane extracts the dropped 
bot’s objects and uses them to replace the entire strip for the 
current Bot. is is a great way to get a fast start or try 
variations. Try dropping some of our sample Strip-Based 
Bots. Note that dropping a single object from the Library 
Primitives will replace just the currently selected Strip 
Object.


Clicking the Import Objects button [3], allows you to select 
any GroBoto Scene file and extract it’s objects. Caution: is 


is a flexible but ‘mindless’ option. It simply takes objects in order 
from the file (up to 30). If the file contains very large or very small 
objects, it might cause problems. It’s best used 
for loading custom scene files that you’ve 
created specifically for this purpose.


Selecting an object
e Strip Object pop-up [4], (or the up/down 
buttons next to it) loads an object from the 
strip into the editor pane, and makes it the 
selected Strip Object.


All of the editor pane controls work just like 
they do with A:B Bots (see the main 
documentation, page 95). Select a different 
shape for the current Strip Object with the 
Shape pop-up [5].
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groBoTip
The Object pop-
up is recreated 
using the 
current editor 
pane camera 
settings each 
time you 
activate it. 


Adjust the editor 
view camera to 
get optimally 
sized miniatures 
in the menu. 


1


3


2


4


5







Enhanced • Bots • Object Strips
Strip Sequence Options
Bots distribute — or ‘sequence’ the Strip Objects in a variety of ways. e ‘Sequence’ 
pop-up sets the sequencing type. e four options are: 


• Object Count
• Bot Taper
• Random
• Bot Shape


Bot Taper Sequencing & the Transition value
Before we look at the Bot Taper option, let’s have a quick look at the internal Bot value 
that drives it.  All Bots have an internal ‘Transition Value', used by the Bot to control 
things like the gradient color, object size, and shape. You can think of it as a 
percentage, from 0 to 100. Each bot sets this value differently, but generally it 
increases from the start to end of the Bot and/or Bot branches. With the Bot Taper 
option, this Transition Value determines which Strip Objects are used by the Bot as it 
grows.  


Typically this transition value is controlled by one of the Bot-Specific sliders (e 
bottom group of sliders in the Bot Panel), usually having titles like 'Branch Taper', or' 
Object Taper'. It is also effected by the A:B Object Skew slider in the Bot Global 
Settings Panel.
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Object Strip - Object 
Strip Bots use the transition 
value to sample from the 
sequence of available objects, 
switching from one object to 
the next.


A:B Objects - A:B 
Object Bots use the 
transition value to gradually 
change the object from its 
A to B settings (making it 
flatter in this example).







Following are examples of the four Sequence 
options. We’ll also look at how each of these 
options is effected by two other settings: e 
Repeat check box, and Strip Sequence 
Stretch slider.


Bot Taper Sequence Type
e transition value (see above), 
controls which Strip Objects are 
used as the Bot grows. 


e Strip Sequence Stretch 
slider controls how the available 
range of Strip Objects (three in 
this example, Sphere, Cylinder, 


Cone), are spread across the 0-100 range of the 
transition value. In figure 1, that slider is set to 
100, so the three available objects in the Strip 
are spread over the entire length of the Bot.


With Stretch values lower than 100 (fig. 2), the 
Bot moves through the Strip Objects more 


quickly, and continues using the 
last Strip Object when the Strip 
Objects runs out.


Combining Strip Sequence 
Stretch values of less than 100 
with the Repeat option (fig 3), 
creates multiple runs of the 


entire strip. So rather than just continuing to use 
the last Strip Object as above, the Bot starts over 
and cycles through the Strip Objects repeatedly.
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Figure 1.


Figure 2.


Figure 3.


This is the three object 
strip used in all of the 
examples above.







Object Count Sequence Type
For each branch, the Bot simply uses the Strip 
Objects in order. When the Strip Objects run 
out, the Bot continues using the last object in 
the Strip (if the Repeat option is not checked - 
Fig. 4).


If you select the Repeat check box, 
(Fig. 5), the Strip repeats, cycling 
through the Strip Objects (1, 2, 3, 1, 
2, 3, etc...). 


e Strip Sequence Stretch slider 
expands and contracts the length of 


the strip cycles (Fig. 6 - showing just 
one cycle, with the Repeat option off, however, 
Strip Sequence Stretch works with repeating 
cycles as well).
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Figure 4.


Figure 5.


Figure 6.


This is the three object 
strip used in all of the 
examples above.







Random Sequence Type
e Strip Objects are selected randomly by the 
bot. e Strip Sequence Stretch slider and 
Repeat checkbox have no effect when the 
random option sequence type is used.


Bot Shape Sequence Type
is option is unique. It is only used 
by Bots that specifically request Strip 
Objects. ese are usually Bots that 
have ‘roles’ for each object in the strip. 
e Fan Bot in figure 8, uses Strip 
Object 1 for the center of the fan, 
Object 2 for the radial arms, and 
Object 3 for the tips at the end of each 


of those arms. e Strip 


Sequence Stretch slider and 
Repeat checkbox have no 
effect when the Bot Shape 
option sequence type is used.


(Beta Note: we will soon fix 
GroBoto so that it disables 


the Bot Shape Sequence option for Bots that do 
not make these specific shape number requests.)
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Figure 7.


Figure 8.







Enhanced Features • Bots • Object Strips


Strip Spacing Options
With Object Strips,  object spacing (the distance between adjacent objects) takes on 
greater importance. Basing spacing on the length of each object is clearly useful with 
the arbitrarily changing lengths of Strip Objects. Some 2.0 Bots already used object 
length based spacing, but others did not. When using Object Strips, you always have 
the option of length based object spacing. e Spacing pop-up gives you four options.


• Bot Controls
• Object Length
• Object Length Random
• Object Length Blend


Notes on Bot Control vs. Object Length Options
Before we describe these four options, a few notes about the first one... 
e Bot Controls Option simply means ‘let the Bot do whatever it 
normally does’. Any of the other options override the Bots normal 
object spacing. Bots may have one or more custom bot-specific sliders 
(e bottom group of sliders in the Bot Panel), that control spacing. 
Using any of the Length-Based options will override those bot-specific 
sliders, and they will cease having any effect on the bot.


In those cases where the Bot (including some 2.0 Bots) is already using 
length-based spacing internally, the Bot Controls and Object Length 
options are interchangeable — switching between them will make no 
difference.


Figure 1 shows a case where Bot Control and  Object Length are 
different. Notice how Object Length changes both the individual object 
relationships and the overall form of the Bot. With some bots — and 


certain  Strip Objects, those differences 
can be dramatic, bringing a new range of 
possible forms into play.
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Figure 1. The pinWheel Bot 
with Bot Control spacing 
(above) and Object Length 
spacing (right).


groBoTip
Some Bots (like OrbNado) 
are very dependent on their 
bot-specific object spacing 
settings. Switching such 
bots to any of the Object 
Length options will radically 
alter their overall form.


This is not a bad thing — a 
new realm of possibilities. 
Just be aware that they will 
be different, and that some 
of their sliders will stop 
having  any effect.







The Four Spacing Options 


Bot Controls - (Fig. 2) Unlike the 
other three options, this option lets 
the bot do whatever it wants with 
object spacing (which may have 
nothing to do with object length). 


General Notes on the Object Length-Based Options


Before we look at the 3 Length-Based  Options, here are 
some behaviors common to all of them: 


e Bot Global Slider Object Scale, plays an important 
role when using any length-based option. When Object 
Scale is 100, the objects are placed end-to-end (Fig. 3a). If 
it’s greater than 100, the objects will overlap (Fig. 3b) — if 
less than 100 there will be gaps (Fig. 3c). Also Note that 
the Step Size Skew slider alters spacing. If it is anything 
other than 0, the objects will have gaps and/or overlaps.
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Figure 3: A                                                           B                                                  C


Figure 2







Object Length - (Fig. 4) Spacing is based on 
the length of each object. e Bot Global 
Sliders Object Scale and Step Size Skew, 


play important roles when using this or any 
of the other Length-based options. Only 
when Object Scale is 100, and Step Size 


Skew is 0, will the objects will be aligned 
end-to-end (see previous page) .


Object LengtH Random - (Fig. 5) Spacing is 
based on Object length, but a bit of 
randomness is thrown in. e greater the 
length differences between Strip Objects, 
the more noticeable this randomness will 
be.


Object LengtH Blend - (Fig. 6) Like the 
other two length-based options above, 
spacing is based on Object length. 
However, any changes in length from one 
object to the next are gradually worked into 
the spacing. 


In Figure 6 you see how the longer rods 
overlap where they begin near the spheres, 
and gradually reach end-to-end spacing by 
the time they reach the second set of 
spheres. ose tailing spheres, in turn, start 
out with large gaps between them, and 
gradually get closer to each other. is 
option offers a nice modeling option, but it 
also serves a special purpose with Morph 
Animation. Object Strip Bots with objects 
of radically different lengths create some 
wonderfully unique motion. However it can 
get a bit wacky. Using Object Length Blend 
spacing tends to calm that wackiness down 
a bit.
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Figure 4


Figure 5


Figure 6







Enhanced Features • Bots • Object Strips


Bot Object Rotation Options


e new 2.1 Bot Object Rotation options are useful for all 
Bots. However they  can be especially important with the 
Object Strip option.


Select the Rotation type with the pop-up located to the right 
of the Object Editor pane in the Bot Objects & Textures panel. 
e three choices are:
• End Rotation
• Center Rotation
• Fixed Rotation


ese options control how the Bot places each object along the 
path of growth.


It helps to think about these options as part of the Bot’s step-by-step growth. 


With End Rotation, each new object starts with the previous objects location and 
growth direction. It is rotated to the new growth direction and then moved in that 
direction. is results in the ‘sawtooth’ pattern as seen above.


With Center Rotation each new object starts with the previous objects location and 
growth direction. It is moved along the path new direction and then rotated. is 
results the regular and orderly alignment seen above.


Fixed Rotation simply ignores the Bot path. All objects keep the alignment specified 
in the Bot Object Editor. is is clearly a specialized option — it prevents the Bot 
from providing its natural object orientation. However, it’s useful (among other 
things), for creating architectural and forms.
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          End Rotation                          Center Rotation                      Fixed Rotation







Enhanced Features • Layered Fog


Layered Fog
Layered Fog adds a more realistic 
altitude and density-based fog.  


You can have one or two fog layers 
in your scene. ese layers are 
always aligned with GroBoto’s 
World coordinates (with ‘Y’ being 
the ‘up’ direction). 


When Layered Fog is selected in 
the Scene Options Panel, it shows a 
Color Swatch and an Edit Fog 
button. e Color swatch changes 
the Layered Fog color. It can be 


dragged into the scene and edited in 
real time using the same Dynamic Color Editing feature used for other 
color adjustments (like Background or Depth Fog colors). All other 
Layered Fog editing is done by clicking on the Edit Fog button. is 
brings up the Layered Fog settings dialog box and triggers a modal fog 
editing session.


Layered Fog and Animation
Enabling layered fog enables it for all keyframes of a morph sequence. e layered fog 
settings can be set independently for each keyframe and smoothly interpolate during 
the morph sequence. Changes to the layered fog (thickness, etc.) for the current 
morph keyframe are saved to that keyframe if the Active keyframe checkbox is set 
*or* when you click the Update Key button.
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Layered Fog Settings Dialog







Layered Fog Settings
Thickness and Transparency
Each fog Layer has four settings: Spread, Altitude, Thickness 
and Transparency. Let’s look at ickness and Transparency 
first. ickness controls how much the fog spreads vertically. 
As ickness increases, the edge gets softer, and the fog gets 
denser. Transparency is simply that — how easily you can see 
through the fog. 


Together these two settings control the character of the Fog Layer. For example you 
may want a very sharply defined layer with a hard edge, or a softer layer with a broad 
edge. Additionally you’ll want to control how much the fog obscures objects in your 
scene.


To achieve these effects, you’ll need to work with both ickness and Transparency — 
balancing them against one another.


In these next few examples Spread and Altitude are unchanged as we concentrate on 
ickness and Transparency.


Figure 2 features low thickness and low 
transparency, resulting in a sharply defined 
fog layer. In  Figure 3 we have increased 
ickness, and also increased Transparency. If 
we had not increased Transparency, the Fog 
would have completely obscured the ground 
and lower portions of the Objects (see Fig. 4). 
Generally that’s the idea — raise or lower both 
ickness and Transparency to maintain 
overall ‘foggyness’. However it’s not a one-to-
one relationship. Notice the small difference 
between Transparency in Figures 3 & 4.
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Figure 4
Spread:100 Altitude:80  
Thickness:67  Transparency:71


Figure 3
Spread:100 Altitude:80  
Thickness:67  Transparency:82


Figure 2
Spread:100 Altitude:80  
Thickness:31  Transparency:48


Fig. 1 Original Scene, No fog







Here are two more examples:
Figure 5 is a very thin, sharp layer. 
Notice that the Transparency has also 
been lowered, otherwise this thin layer 
would have very little obscuring effect 
on the objects below it. Layers this 
thin are a bit unnatural, the edge is 
very sharp on both objects and 
horizon.


Figure 6 goes in the opposite direction 
of Fig. 5. is is a very thick, soft-
edged layer. Notice that transparency 
is quite high (90). We’ve also moved 
the altitude down (first time we’ve 
changed that in this set of examples). 
is places the base of that big, soft 
edge at ground level giving us a very 
gentle transition that is densest at 
ground level.


Spread and Altitude
Altitude is pretty simple. It just moves 
the entire layer up or down.


Spread is a bit more interesting. It 
determines how far the fog layer 
spreads out from the center of the 
GroBoto universe towards the 
horizon. At 100, it’s virtually infinite. 
is is the most natural look if you are 
creating a typical terrestrial scene. 
With lower values, Spread reveals that 


our layers are not flat planes but actually elliptical blobs (when spread is 100, these 
blobs are so flat, they might as well be planes). In future versions we will use this same 
effect to provide arbitrarily positioned and sized glow & bloom effects.
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Figure 6
Spread:100 Altitude:o  
Thickness:81  Transparency:90


Figure 5
Spread:100 Altitude:80  
Thickness:18  Transparency:42


Fig. 7 Range of Spread settings; 25, 35 and 100







Enhanced Features • Layered Fog


Self-Illumination 
Objects and Textures


Self-Illumination makes objects light-up on 
their own, without any external light 
source. eir surface will be visible — even 
very bright — without any lights in the 
scene. If there are lights in the scene, the 
Self-Illumination is added to the effect of 
those lights. It’s as if the object has a light 
inside (however, Self-Illumination is not a 
light source, it’s effect is limited to the 
objects to which it is applied). A common 
approach to making self-illumination more 
convincing is to place a local light inside 
the illuminated object — more on that later.


GroBoto offers Self-Illuminated Objects 
and Self Illuminated Textures. 


ere are two settings for Self-Illumination,
Color and Intensity. ese settings are 
available in the Selected Object Properties 
Panel and the Texture Panel.


e visual effect of making an object 
Self-Illuminating, or attaching a Self-
Illuminating texture to an object is 
identical. e differences and advantages 
of each approach will be covered below. 
Until we get to that point, we’ll just talk 
about Self-Illumination in general.


Important Note: e Self-Illumination 
color swatch, unlike some other control 
adjustment swatches in GroBoto, does 
not currently support drag & drop, 
dynamic color adjustment. To change 
the color, click on the swatch to display 
the color selection dialog.
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Self-Illumination Variations


In each of the figures below, a normally lit object is on the left, and variations of the 
same object with self-illumination on the right. In that right-side group, Self-
Illumination is the dominant effect (only one, dim light above and behind).


In this group, we see the effect of Self-Illumination on a plain gray object:
None, then Red, Green, Blue with an intensity about 1.0.


It gets more interesting with a textured object — Illumination settings:
None, then Red, Green, Blue with an intensity about 1.0.


Now the same group with different intensities of white illumination:
None, then white with intensities about 0.5, 1.0, and 1.5.


ese two groups show how Self-Illumination interacts with different textures. e 
Self-Illumination settings are the same for the upper and lower groups (a variety of 
colors and intensities). Notice how the darker shades in the upper group’s textures are 
virtually unaffected — even with high intensity as seen on the rightmost object — 
while the lower group (with a less contrast in its texture) illuminates more evenly. is 
is because Self-Illumination is essentially a multiplication of the texture and 
illumination colors.
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Self-Illumination - Objects vs. Textures


As mentioned above, the visual effect of making an object 
Self-Illuminating, or attaching a Self-Illuminating texture to 
an object is identical . So why choose one over the other?


In one case you don’t have a choice — AutoBots. You can’t 
make an AutoBot’s objects Self-Illuminating. All object 
properties are controlled by the Bot. So assigning a Self-
Illuminating texture to the Bot is the way to go. (Note that 
Tint color does effect Self-Illumination.  You can get some 
nice effects with the combination of a Self-Illuminating 
texture, a gradient, and ‘Tint Texture’ on in the Bot Panel). 


With all other (non-AutoBot), objects in your scene you have a choice — and it comes 
down to convenience and efficiency. 


Advantages of Self-Illuminating Textures: ey can be easily applied to large numbers 
of objects and provide a single place to globally modify the settings of all of them, (the 
Texture Panel).


Advantages of Self-Illuminating Objects: If you want to illuminate several objects — 
each of which has a different texture — Object Self-Illumination is  easier and more 
efficient. Otherwise you would need to create self-illuminated version of each of those 
textures (and perhaps those textures are shared by illuminated and non-illuminated 
objects).


You have more individual object control with Object Illumination. Each object can 
have its own texture, tint color and illumination setting. With Texture illumination 
you can only vary the tint color of the individual objects assigned that texture.


Note: Object Self-Illumination takes precedence over texture Self-Illumination. So if 
an object has Self-Illumination enabled and a self illuminating texture applied, it’s 
object Self-Illumination settings will be used.
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Fig. 3 Bot with Self-Illuminating 
Texture and gradient tinting.







Enhancing Self-Illumination with Local Lights


Enabling Self-Illumination does not create a new light source. In some cases this is 
fine... little running lights on a UFO, or windows in a distant building for example. 
Having each of those objects  act as a true light source might be excessive.


On the other hand, we can use Self-Illumination to emulate a light source — a lamp, a 
light bulb, a mysterious glowing orb. In those cases we expect that illuminated object 
to cast light on other, nearby objects. Combining local lights with illuminated objects 
does the trick.


Self-Illumination and Animation
No AutoBot Texture properties animate. is includes Self-Illumination. However, 
since AutoBot Object Colors & Gradients to animate, you can indirectly control a 
morphing AutoBots Self-Illumination to a limited extent.
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Fig. 4 Scene with Self-Illuminated sphere 
without local light & with local light added near center of sphere







Enhanced Features • Sky & Stars


Sky Gradient & Stars 
GroBoto offers simple Sky effects including a gradient and 
stars. ese effects, when combined with our new Layered 
Fog, give your GroBoto scene a greater ‘sense of place’.


e Sky Gradient and Stars are infinitely far away — but 
you can think of them as being mapped onto a very distant 
‘Sky Sphere’. e GroBoto universe is centered inside of that 
sphere. When we look straight up, (GroBoto’s ‘Y’ direction) 
we see the north pole, the equator of that sphere is straight 
ahead on the horizon line.


Sky Stars & Layered Fog all operate in this coordinate 
system. e Sky Gradient has one color at the equator, 
another color at both poles. e Fog layers lie in the X-Z 
plane — extending out to that distant equator. 


If you want a natural looking scene, you’ll need to orient 
your objects to match these world coordinates. All of 
GroBoto’s built-in ‘Stage Objects’ and Scene Presets are set 
up that way (usually with a flat Stage Object object 
representing a ‘ground plane’).


For best results any Stage Object 
should be located right in the 
center of the GroBoto universe.


is diagram does not represent 
the relative scale of the Sky & Stars 
elements. However, it gives a 
general idea of the spatial 
relationship between these core 
environment elements. Keep in 
mind the ‘Sky Sphere’ is huge & 
very distant (and not an actual 
object).


2. Cutaway Sky Sphere with 
gradient from equator to 
poles


3. Y Axis (Up)
4. Stage and other objects
5. Fog Layer (Note that it is a 


flat layer concentrated 
near the equator).
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e Sky Gradient is vertically symmetric —with one color at the horizon, a second 
color at both poles and a smooth transition in-between.


Sky Gradient Controls: 
e Overhead and Horizon color swatches set the colors. Note that you can use 
GroBoto’s Drag & Drop dynamic color editing with these swatches (see main 
docs page 14 )


e Angle slider controls the two midpoints of that symmetric gradients. It sets 
the angle of that midpoint relative to the horizon. A small angle creates a narrow 
strip of near the horizon, larger angles create broader, more gentle gradients.


Of course, what part of the gradient you see — and how much you see, depends 
on your camera’s direction and settings. Figure 2 was made with the camera 


pointed straight ahead, and a moderately wide field of view.


Star Controls
Stars are randomly distributed throughout the ‘Sky 
Sphere’.


• Count – Number of stars rendered.
• Size – Changes the size of the stars in pixels. is 


star size will be scaled when rendering to file or 
animation, maintaining the relative size of stars to 
other objects in your scene.


• Clustering – Increasing this value to makes the 
stars tend to group together, or ‘cluster’.


• Randomize Stars – Click this button to generate a 
new star pattern.


Note that all of the Stars controls only update on mouse-up (or when you tab 
or hit the enter key if you are editing text values).
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Fig. 2 Sky with Angles: 12, 45 and 72







Enhanced Features • Texture Mapping


Aligned Textures 
GroBoto has a unique tiled texture mapping system that 
creates organic surfaces without seams or repeated patterns, 
(see main docs page 66).  It does this by randomly placing 
and rotating masked texture tiles on the object surfaces.


We have enhanced that system giving you control over how 
much rotation is allowed. Limiting rotation results in tiles 
with aligned orientations. is makes it possible to produce 
things like tree bark, stone walls, and steel plating.


Note that this is not regular-grid tiling (the kind used for 
repeating, tiling textures). e tiles are still placed randomly, 
only their rotation is limited. We do plan on offering regular 
tiling in future versions of GroBoto.


All GroBoto object primitives have a natural ‘up’ direction (green arrows in 
figure 1). By default (for example when you drag an object into the scene from 
the Library), an objects up axis matches the Y axis of the GroBoto universe. 
An aligned texture’s, default orientation matches the object’s up direction. 


e Limited Rotation settings are made in the Texture Tiling dialog (Figure 2, 
opened with the Tiling Properties item from the Options menu in the 
Texture Options panel).


• Limited Rotation -  Enables/Disables limited rotation. When off, tiles 
are free to fully rotate.


• Starting Angle - Initial orientation of the tiles, relative to the object’s 
natural ‘up’ angle.


• Rotation Range - Amount of random variation in tile angle.


Setting both the Starting Angle  and the Rotation Range 
of the Texture Tiling, to 0 results in all of the tiles being 
aligned to that object up direction. If you allow some 
variation (by setting the Rotation Range greater than 0), 
you’ll get tiles randomly oriented within that range (a +- 30 
degree range is represented by the gray arrows in figure 1).
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Fig. 1


Fig. 2







e Starting Angle rotates the initial orientation of the tiles. e Rotation Range is 
always relative to that Starting Angle. Figure 3 shows a texture with a 0-degree 
Starting Angle (3a) vs. a 90-degree starting angle (3b). Note that the actual Rotation 
Range used to produce the textures was +- 9 degrees — much less than what is shown 
by the green & gray arrows.


Designing Aligned Textures
Aligned textures are composed of the same 
elements as all other GroBoto textures:


• tiling scheme
• color map
• bump map  (optional)


(see main docs page 66).


Normally, the combination of Tiling Scheme and 
Color map is arbitrary. In fact mixing and 
matching different Tiling/Map combos can be a 
great way to generate greater texture variety. 
However, with certain aligned textures, using a 
specific tiling scheme that matches the color map is 
called for.


e ‘Tiles 3-Stone’ texture included with GroBoto 
is a good example. Its tiling mask (Fig. 4a), and 
Color Map (Fig 4b), work together. See page 71 of 
the main docs (Building a Custom Tiling Texture) 


for information or creating this sort of texture.
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Fig. 3a Fig. 3b


Fig. 4a


Fig. 4b
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